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1 About Outpost 
1.1 What is Outpost? 

Outpost is a PC-based messaging client that lets you to exchange your packet 
messages with almost any Amateur Radio Bulletin Board System (BBS). 

Using your existing Terminal Node Controller (TNC) or AGWPE-enabled sound-
card, radio, and a Windows-based PC, all you need to know is your call sign, 
information about your TNC, and information about the BBS.  Once the program is 
configured, Outpost then manages all message-handling between your PC and the 
BBS.  Outpost also lets you send, receive, read, delete, create, reply to, or forward 
messages back to the BBS. 

Unlike commercial mail systems, BBS-based mail is transmitted unencrypted over 
the amateur radio bands.  There is nothing private about it. 

1.2 Why Outpost? 

Outpost was created to support the packet communication needs of an ARES, 
RACES, or other emergency communications response team during a disaster or 
other activation where Amateur Radio is deployed. 

During an emergency, you may be required to pass lists of information or detailed 
instructions within an Operational Area to support Logistics, Operations, or 
Planning/Intel activities as required by a municipality’s Emergency Operations 
Center (EOC).  Packet is ideal for this task.  Outpost makes the job even easier by 
automating the manual interaction between you and the BBS. 

Because Outpost leverages the existing packet infrastructure, it can be deployed 
relatively easily and quickly.  Outpost can either operate as a single stand-alone 
messaging client, or collaboratively with other Outpost stations using built-in 
features that enhance overall message handling effectiveness. 

If Outpost had a tag line, it would be: “Focus on the message, not the medium.”  
An emergency activation is not the time to think about packet training.  By using an 
application with a look and feel similar to contemporary email clients, Outpost 
helps emergency communicators get a packet message written and transmitted 
quickly without all operators needing to be packet experts. 

A successful Outpost deployment does require a few things:  

 At least one individual who has a fundamental understanding of packet, and can 
configure and verify that Outpost is operational prior to a response. 

 A definition of your emergency response team’s operating policies for packet 
messaging.  Operating policies are the guidelines that would be observed 
during an activation.   
 
Examples of a policy would be things like (i) no keyboard-to-keyboard 
communications will be used, (ii) polling the Operational BBS will occur no 
more frequently than every 15 minutes, (iii) tactical call signs will be used, etc.  
Most packet messaging policies can be implemented through Outpost. 
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1.3 A typical TNC Session today 

Before Outpost, if you wanted to send and receive a packet message, you needed a 
terminal emulator program and be familiar with the commands for controlling your 
TNC and a remote BBS.  For instance, you probably did something like this: 

Figure 1: Sample TNC session using Hyperterm 

1. Turn on your Computer and run your terminal emulator.  You may be using 
PACTERM or some other TNC program.  I’ve used the general-purpose 
MS-Windows HYPERTERM program because of its ability to cut-and-
paste text to and from it. 

2. Turn on your TNC.  Verify you see the TNC welcome message.   

3. Turn on your radio and select the frequency on which the BBS operates. 

4. Check the configuration of the TNC.  This could include sending the MY 
command to review or change the TNC’s call sign, setting the date and 
time, or changing any display settings with the ECHO or AUTOLF 
commands. 

5. Connect to the BBS.  After issuing the Connect <call sign> command, you 
verify the BBS responds with its welcome message. 

6. Once connected, you check for messages addressed to you with the LM (list 
mine) command.  If you operate NTS packet, you may check for any NTS 
messages with the LT (list traffic) command.  Then, you may read them 
with the Read <####> command (where #### is the message number) and 
delete them off the BBS with the Kill <####> command. 

7. You may also check out current bulletins with the LB (list bulletins) 
command, and then read them one by one. 

8. If you wanted to send a private message to a friend, you would enter the  
SP <call sign> command (send private).  When prompted, you enter the 
subject, and then the message.   

NOTE:  As a reminder, every time you press Enter on your keyboard, the line of text you 
just typed is sent to the TNC and transmitted to the BBS.  The only way to 
correct an error in your message is to finish your message, delete it from the 
BBS, and start over. 
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9. When done, you exit the BBS with the B or Bye command. 

10. Because you don’t know when the other person would get the message, you 
would repeat steps #5, #6, and #9 to see if you have a reply. 

During normal operation, the above steps can get tedious, in particular if you are 
expecting a reply. 

During an emergency, you may have an established routine to do something similar, 
with more purpose and intent to the steps outlined above. 

1.4 A Typical Outpost Session 

Outpost takes care of a lot of the above steps.  Once configured, Outpost takes on 
the job of sending and processing all TNC and BBS commands during a “Packet 
Send/Receive Session.”  Because you have previously told Outpost what the TNC 
and BBS prompts and commands are, Outpost automatically sends, waits, receives, 
and processes all exchanges with the BBS. 

 

Figure 2: Outpost’s Main window 

Here is what you would do with Outpost: 

1. Turn on your Computer and run Outpost.   

2. Turn on your TNC.   

3. Turn on your radio and select the frequency. 

4. Confirm that Outpost has the correct TNC and BBS selected. 

5. From Outpost, press the Send/Receive button. 

6. Outpost will automatically: 

▪ Send the appropriate TNC commands to get it ready for a Send/Receive 
Session. 

▪ Connect to the BBS by sending the Connect <bbs> command. 

▪ Check to see if you have any private messages in the Outpost Out Tray 
to be sent to this BBS.  If so, it will send them with the SP Command.  
It then does the same for any NTS or Bulletins you may want to send. 
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▪ Check for messages addressed to you with the LM command.  Outpost 
will read these messages with the R <####> command, then delete 
them off the BBS with the K <####> command.  Outpost will also 
check for and retrieve NTS and bulletins if selected. 

▪ Finally log off the BBS with the Bye command. 

▪ If configured, Outpost will repeat this cycle on a regular interval as 
defined by you. 

In short, Outpost automates the Packet Session by sending TNC and BBS 
commands, looking for prompts, and responding with the next appropriate 
command.  

Whatever you manually type at the keyboard into your terminal emulator program, 
Outpost does this for you automatically. 

1.5 Outpost Features 

Message Management 

1. Multiple mail folders.  Outpost lets the user manage messages in a series of 
folders, including an In Tray, Out Tray, Sent Folder, Draft, Archive, and 
Deleted Items Folders.  These folders are permanently defined. 

2. Message Types.  Outpost supports three primary message types:  Private, 
NTS, and Bulletins.  Sent and received messages are displayed with their 
appropriate types indicated. 

3. Address book.  The user can create entries for a single user or for a 
distribution list. 

4. Profiles.  You can have different configurations of settings that can be 
quickly loaded to match your operational situation – casual, emergency, etc. 

5. Message Creation.  Outpost allows messages to be created from scratch, 
importing text from an ASCII file, cut and pasted in from other 
applications, or by Replying to or Forwarding a previously received 
message. 

6. Text Message Formatting.  Messages can be entered in a free-form text 
area.  Simple formatting can be performed, errors corrected, and text can be 
added and deleted prior to sending the message. 

7. NTS Message Maker.  Outpost also helps format NTS messages.  The NTS 
Message Maker is a fill-in-the-blanks form that prompts for all required 
fields needed to create a correctly formatted NTS packet message.  ARL 
Messages can also be added and automatically formatted. 

8. Report Interpreter.  Outpost supports an online report interpreter that helps 
get a pre-defined report filled in and formatted quickly. 

9. Message archiving.  After an emergency, the entire message database can 
be archived to either an Outpost-readable format for importing later on, or a 
user-readable format. 
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Packet Session Management 

10. Serial Comm Port Management.  Outpost supports direct serial 
communications with a TNC by setting up the serial port and handling any 
contention for the port that may exist. 

11. AGWPE Support.  Outpost supports the AGWPE application located either 
locally on the same PC as Outpost, or somewhere else on the network. 

12. Telnet Support.  Outpost supports Telnet access to a network-accessible 
BBS.   

13. Interface Management.  Outpost sends all initialization commands to the 
TNC, AGWPE, and Telnet interface to prepare it for a Packet Session. 

14. BBS Management.  Outpost sends the right BBS commands at the right 
time. 

 

Figure 3: Outpost’s New Message window 

15. Support for several popular BBSs and PBBSs, including: 

• KPC2, KPC2400, KPC3+, KC9612, KAM (all models), Data Engine 
• PK-88, PK-96, PK-232, DSP-232 
• MFJ-1270x, MFJ-1278 
• AA4RE (standard and with the Tactical Call Customization) 
• BPQMailChat 
• DXNET 
• F6FBB 
• HAMSERV 
• JNOS, SNOS, TNOS  
• MSYS 
• OpenBCM 
• N0ARY 
• Winlink’s RMS and CMS  
• W0RLI 

Configurations and Setups 

16. Interface configuration setup 

17. TNC configuration setup.  Outpost manages a list of Interfaces, TNCs and 
their commands.  TNCs can be added or deleted. 
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18. BBS configuration setup.  Outpost will manage a list of BBS’s and their 
commands.  BBSs can be added or deleted.  TNCs can be linked to a BBS 
entry for quick BBS selection. 

19. Message retrieval.  Outpost allows the user to choose which types of 
messages will be checked for and retrieved from the BBS.  The three 
message types are: Private, NTS, and Bulletin. 

20. Retrieval Automation.  You can configure Outpost to run a Send/Receive 
Session automatically at a specific time interval set (in minutes).  

21. Station Identification.  The Station ID (Call Sign) can be changed. 

1.6 The Outpost operating environment 

Outpost can operate in a number of packet environments where one or more BBSs 
are used as message drops (Star network).  For instance, it may be operating in a 
network along with other Outpost users or other terminal emulator program users 
with a system running BBS software.  In Santa Clara County, W6XSC-1 is the 
county’s packet BBS system serving several San Francisco South Bay Area city 
EOCs. 

TNC
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Figure 4: Central BBS Station serving many Packet users 

Outpost could also be operating in a smaller closed packet network where one user 
has enabled a TNC’s Personal BBS (PBBS) feature thereby providing a low cost 
central message drop for several stations.   
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Figure 5: A PBBS Station as a central mail drop 

1.7 What Outpost does not do 

• Outpost does not support any of the bulletin board forwarding protocols.  Instead, it 
automates sending commands and interprets the returning prompts of both the TNC 
and the BBS to manage message handling. 

• Outpost does not support any of common email protocols such as POP3 or SMTP.  
However, internet mail is available indirectly through Winlink’s RMS and CMS 
nodes. 
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2 Installation 
2.1 System requirements 

Outpost has been verified to run under the following operating system 
environments: 

• Microsoft Windows 98, NT, 2000, ME, XP, Vista, Windows 7 and 8. 

2.2 Hardware requirements 

MS-Windows requires the following hardware: 

• Intel-based PC required to support any of the above MS Window Operating 
Systems 

• Open Serial Port for Serial or AGWPE interfacing, or  

• USB port with a serial adaptor to connect to the TNC 

• Network interface for remote AGWPE or Telnet interfacing 

2.3 Download from an Internet 

Installing the software off the Web begins by downloading the Outpost Install 
Program to your PC.  

1. Create a Temp directory on your PC such as optemp (or any other existing temp 
directory will work fine). 

2. Go to the website (www.outpostpm.org), navigate to the Downloads section, 
and look for Outpost v2.7 Installation.   

3. Right click on the link, and select “Save Target As”.  Enter a directory to save 
the installation program to your temp directory.  The install program is named 
opsetup270ixx.exe, where “xx” is the current installation version. 

2.4 Outpost v2.7 installation 

The Outpost 2.7 installation program comes with all files needed to install Outpost 
on your PC.  After downloading the install program from the Outpost website, run 
the program.  Here are the install steps that are presented. 

1. Click on the opsetup270ixx.exe program (where xx is the latest release). 

2. Double-click on the install program to start the installation process. 

3. Information.  This is general information that you should check out depending 
on the type if install you want to perform.  When done, press Next >. 

4. Select Destination Location.  The usual and default location is provided.  Unless 
you really want to install Outpost somewhere else, just press Next > to proceed. 

5. Select components.  Outpost can install program components in the following 
configurations: 

a. Update for Existing users:  This installs all Program Files only.  This 
is ideal since it updates only the components that changed since the 
last release.  While this is primarily the Program Files, you may want 
to check the User Documents component as well to get the latest user 
guides for this release. 
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NOTE: Do not check “Sample TNC and BBS configuration files”… 
this will overwrite whatever config files you currently have. 

b. First time installation for new users:  This option installs all 
components; programs, documentation, sample files, etc.  You can 
uncheck specific components as necessary. 

c. Custom Installation:  This option lets you pick whatever components 
you want to install. 

Choose which ever installation option is right for you, then press Next >. 

6. Select Start Menu Folder:  The location where the install program will place the 
program short-cuts.  Take the default location offered unless you want to pick 
someplace else. 

7. Select Additional Tasks:  The only task available is creating icons on the desk 
top.  This is purely your option, but most people select it anyway. 

8. Ready To Install:  all choices are made, and this is a summary of the options you 
selected.  Press Install to continue with the install process. 

9. Data Update.  The install program will automatically run opupdate27.exe to 
update the following data files: 

a. Message database – Outpost.odb  
b. TNC data file – TncInfo.dat 
c. BBS data file – BbsInfo.dat 
d. BBS path files – bbs_name.pth 
e. Message.log – logging used to support Ics309 Comm Log Builder 

10. Information:  This is yet another info window that describes some of the new 
features with v2.7. 

11. Finally… you can view the README.TXT file or run Outpost directly. 

12. When done, run Outpost as usual. 

2.5 Installation from CD-ROM or USB Flash Memory 

You can create an install CD-ROM or Flash Memory by copying the installation file 
to this device.  See your specific system instructions for creating a CD-ROM.  Once 
the CD is created: 

1. Insert the Outpost CD-ROM or Flash Memory into the computer.  

2. On the Task Bar, select START, select RUN.  Enter the command  
D:\opsetup270ixx.exe, where “D” is the CD-ROM or Flash Memory Drive (use 
the appropriate letter if your system’s device is different). 

3. Follow the procedure from Section 2.4 Outpost v2.7 installation above.  

All system software is now loaded and the system is ready for use.  Refer to the 
other sections in this manual for information on configuring and controlling the 
Outpost application. 

2.6 Operating System Considerations 

Outpost has the capability of independent operation where it will periodically poll 
the BBS for any new incoming message traffic.  Because of this feature, the PC can 
run unattended. 

However, this absence of any user interaction may cause the PC to think that it is 
idle and invoke any enabled power management features such as “Turn off Hard 
Disks,”  “System Standby,” etc. 



Outpost Packet Message Manager v2.7 
Users Guide 

January 15, 2013 11

If you intend to run Outpost unattended, set these features to NEVER or OFF.  
These properties should be accessible from the Control Panel.   

Additionally, depending on your hardware, specific BIOS setting changes may also 
have to be made. 

Figure 6: Sample Power Option Setup Menu on a Windows XP System 
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3 Getting started 
 

Outpost manages and controls all aspects of the message “send and receive” 
process.  This section describes how to use Outpost. 

3.1 Station Identification 

When you start Outpost, you are presented with the Station Identification window 
that displays the last set Profile (see Section 6 Setting up Profiles), the Legal Station 
Call Sign and name of the Call Sign owner that was entered the last time Outpost 
was run.   

If this information is still correct, then press OK to continue.  If the operator’s legal 
call sign and name are different from what is listed, then enter your call sign and 
name in the fields.  Press OK when done.   

 

Figure 7: Station Identifier Window 

The field below the User Name is the Tactical Call field.  See Section 11 Using 
Tactical Calls for details on how to set up Tactical Calls.  
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3.2 The Main Outpost Form 

From the main Outpost form, you can manage your messages, perform application 
setups, and control your Send/Receive Sessions. 

This form has one view that allows the user to review messages stored in several 
different folders.  The form is divided into four primary areas:   

Figure 8: Main Outpost Window 

3.3 Menus and Toolbars 

The Program Controls portion of the main Outpost form controls the operation and 
execution of all program tasks.  

 

Figure 9: Main Screen Menu and Tool Bar 

The Outpost menus provide different options for setting up and controlling the 
application.   

NOTE:  Some of the more common menu items are also implemented as Tool Bar buttons.  
See the associated menu item below for the description. 

Menus Description 
File 
 

New Message:  Opens a new message window for 
creating a message.  

Save As:  Saves the highlighted message to an ASCII text 
file. 

Save As, No Headers:  Saves the body of the 
highlighted message to an ASCII text file without the 
message headers (From, To, Date, Subject). 

Save All:  Saves all the messages in the current folder to a 
single ASCII text file.  Messages are separated by a header 
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Menus Description 
line and a Form Feed character, thereby allowing this file 
to be sent directly to a printer for bulk printing. 

______________________________________________ 

Export:  Writes the message database to a “*.oaf” 
(Outpost Archive) file.  This file can be later used for 
importing messages back into Outpost. 

A submenu lets the user to select messages from either  
     All Folders,  export all folders. 
     This Folder,  export the currently selected folder. 

Import:  Reads the file created by the Export function.  
Messages are loaded back in the same folder from which 
they originated. 

Delete all Messages:  Deletes all messages in all 
folders.  This function can be performed any time, but 
probably after performing a full or partial export of 
messages to an archive file.  When selected, the user will 
be prompted whether they want to continue.   

This feature actually does the following: 

1. Outpost renames the current Outpost.odb file to 
Opyymmddhhmmss.odb  

2. Creates a new (and empty) Outpost.odb file.  

NOTE:  If the user really did not want to delete all 
messages, he/she can: 

1. Exit Outpost 

2. rename Outpost.odb to something else 

3. rename Opyymmddhhmmss.odb to Outpost.odb 

4. Run Outpost.  All messages will be present. 

______________________________________________ 

Change Folder:  displays a sub-menu of all the available 
folders.  Clicking on a folder name will display messages 
stored in that folder.  These folders are: 

 In Tray 
 Out Tray 
 Sent Msgs 
 Archive  
 Draft Msgs 
 Deleted Msgs 

______________________________________________ 

Print.  Allows the user to select a printer, then print the 
currently highlighted message to the printer. 

Print, No Headers.  Same as Print above, but no 
message header (BBS, From, To, Subject, Date) is printed.  

Print Setup.  Allows the user to select a default printer 
for Outpost.  

______________________________________________ 

Most Recently Used List.  As BBS/TNCs combinations 
are executed, a BBS | TNC entry is displayed here.  When 
double-clicking on an entry, the BBS and TNC entry are 
loaded together.  The default number of entries displayed 
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Menus Description 
is 4.  To change this setting, see the Tools > General 
Setting menu. 

______________________________________________ 

Exit:  Exits the program. 

 
Edit Delete.  Deletes the highlighted message from the current 

folder.  If the selected folder is the “Deleted Msgs” folder, 
then the user is prompted to confirm the delete request, and 
then the message is permanently deleted. 

Move to Folder.  Moves the highlighted message to 
other folder specified by the sub-menu choice. 

Copy to Folder.  Makes a copy of the highlighted 
message to other folder specified by the sub-menu choice. 

 
Setup TNC.  Manages the different interface methods – TNCs, 

AGWPE, and Telnet.  Users can select or update an 
existing interface and its associated parameters, or create a 
new interface by entering the TNC prompts and 
commands.   

See Section 4 Setting up Interfaces for more information. 

BBS.  Manages the list of available BBSs.  Users can 
select or update an existing BBS, or create a new BBS 
entry by entering a BBS friendly name, connect name, 
prompts and commands.   

See Section 5 Setting up a BBS for more information. 

Identification.  Allows the user to change the legal call 
sign that Outpost uses, the user name, and to optionally 
select a Tactical Call to be used for logging on to the BBS. 

See Section 13 Using Tactical Calls for more information. 

Address Book.  Manages a list of user defined address 
entries.  Addresses can either be a single address for a user 
name (i.e.: Name is JIMOB, address is KN6PE), or a list of 
addresses as a Distribution List.   

See Section 10 Using the Address Book for more 
information. 

PC Time Check.  Opens a tool that reports on, and lets 
the user update, the PC date and time.  This can also be set 
to automatically open this tool when Outpost starts from 
the Tools > General Settings form.  This is useful for PCs 
that tend to get out of time synch and potentially lead to 
incorrect message time stamping. 

 

 
Tools Send/Receive Settings.  Sets various parameters to 

control each Send/Receive Session, including: 

 Automation.  Selects one of the 4 methods for 
scheduling Packet Sessions. 

 Retrieving.  Selects the messages to be retrieved from 
the BBS.  
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Menus Description 
 Receiving.  Selects what Outpost will do after a 

message is received. 

 Other controls that control printing and Alerts. 

See Section 11 Customizing the Send/Receive Session for 
more information. 

Message Settings.  Sets various conditions to control 
how messages are handled, including: 

 Settings for New Messages, Default Destinations, 
auto-message numbering, and signatures. 

 Replies and Forwards. 

 Requesting Delivery or Read Receipts. 

 Message deletes and external program message 
handling (such as PacFORMS, ICS213) 

See Section 9, Customizing Message Settings for a full 
description. 

Report Settings.  Allows the user to set up report values 
by Online Reports, ICS309, and NTS message creation, as 
well as configure specific on-line reports to be loaded with 
a single F-key stroke. 

See Section 15, Online Reports for a full description. 

Log Settings.  Sets up different log options used for 
debugging TNC or BBS problems when they occur. 

General Settings.  Minor options for program control. 

Script Settings.  Defines the names of the scripts to be 
run at the start of an Outpost Session or on Outpost exit. 

Scripts.  Presents 2 submenus that allow you to run the 
scripting tool or pick and run a predefined script. 

See the Outpost Scripting Users Guide for details. 

______________________________________________ 

Packet Session Counter Reset.  The session counter 
is displayed in the Packet Session Log.  This command 
resets the counter back to zero. 

______________________________________________ 

Empty “Deleted Items” Folder.  Deletes all messages 
in the “Deleted Items” Folder.  Once deleted from here, 
they’re gone for good. 

______________________________________________ 

Reset Column Widths.  Restores the Message List 
Display columns to a default size.  This option is great for 
redisplaying previously hidden (or lost) columns. 

Pack Column Widths.  Forces the Message List Display 
column widths to align to the max size of the column 
content. 

Reset form to normal:  Occasionally, the form gets 
stuck in either a minimized state or a maximized state, and 
cannot be restored to a movable window.  This button 
resets the form to the default setting. 
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Menus Description 
Interactive Packet.  Brings up a terminal emulator that 
gives you interactive packet access to your TNC or BBS 
(outside of a Packet Session) by either a Serial Port device 
(TNC), AGWPE, or Telnet. 
 

Forms ICS 309 Communications Log.  Runs the ICS 309 
report builder.  The Ics309clb.exe program reads the 
message transaction history from Outpost and presents a 
series of reporting options for the user to create an ICS 309 
Communications Log for packet messaging. 

See the ICS 309 Communications Log Builder Users 
Guide for details. 

ICS 213 Message Form.  Runs the ICS 213 Message 
Maker. The Ics213mm.exe program presents a standard 
ICS 213 message form. 

See the ICS 213 Message Maker Users Guide for details. 

Add-in Forms.  Outpost reads the Launch.ini file located 
in the data directory and loads the available form or 
program names for scheduling from Outpost. 

Outpost will check if the form file exists, and if it cannot 
find it, the entry will be loaded, but disabled (grayed out). 

 

Actions Send only.  Initiates a Packet Session for sending any 
messages in the Out Tray.  No BBS message checking is 
made.. 

Send/Receive.  Initiates a Packet Session with the 
selected BBS. 

New Mail Message.  Opens a new message window for 
creating a message.  

Open a Message.  Opens the currently highlighted 
message in the message list. 

______________________________________________ 

Force Bulletin Retrieval, one time.  When checking 
this option, if Retrieve Bulletins is checked, Outpost will 
retrieve all bulletins selected for retrieval regardless of 
whether they were previously retrieved. 

______________________________________________ 

View Outpost Data Directories.  Opens Windows 
Explorer to the location where Outpost data files and data 
file subdirectories are located. 

______________________________________________ 

On-line Report Definition #[1-4].  The name of a 
predefined report that was set up in Tools > Report 
Settings menu.  Pressing the associated F-Key loads the 
report into a message form. 

 

Help My IP Address.  Displays the network IP address and 
host name for this PC.  This is useful when setting up 
ICs213mm. 
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Menus Description 
About Outpost.  Description of this program; includes 
the License and Terms of Use. 

 
Profile Shows the current Profile selected.  It also allows the user 

to select a different profile. 

3.4 Folders and Shortcuts 

Outpost keeps messages in 1 of 6 fixed folders.  Once a folder is selected, the 
contents of that folder are displayed and the selected folder name is shown above 
the message list area. 

 

Folders Description 
In Tray Messages retrieved by Outpost from the BBS are placed in 

the In Tray.  The Date/Time field is set to the time that the 
message originally was posted to the BBS. 

 

Out Tray On creating a message and pressing Send on the message 
form, the message is saved in the Out Tray.  The Date/time 
is set to “none.”  Messages in this folder can be opened, 
viewed, edited, and saved back to this location. 

Only valid messages can be sent.  A valid message 
includes a message with all fields filled in and the Send 
button was pressed. 

Outpost checks this folder for messages addressed to the 
currently selected BBS and sends these messages 
regardless of type (Private, Bulletin, and NTS).  

 

Sent Msgs Once a message is sent to the BBS, Outpost moves the 
message to the Sent Msgs Folder with the date and time 
set to the time it was sent.  This time may be different from 
the time assigned by the BBS. 

Messages in this folder can be opened, viewed, printed, or 
forwarded to another BBS user. 

 

Archive This folder is an ad hoc message folder. 
 

Draft Msgs This folder contains messages that were not completed.  
Only a Subject is required to Save a message to this 
Folder. 

 

Deleted Msgs This folder contains all messages previously deleted from 
all other folders.  

Messages in this folder can be opened, viewed, forwarded, 
replied to, or moved or copied to any other Folder. 

Deleting a message from this folder permanently deletes it 
from Outpost. 
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3.5 Message List Area 

The message list area is where messages residing in the selected folder can be 
selected.  Unread messages in the In Tray will be displayed in BOLD text.  Once a 
message is read, it will be displayed in regular (unbolded) text. 

Messages created in Outpost that where Saved will be listed in BLUE text with the 
word DRAFT in the Type field.  Once they are opened and the Send button is 
pressed, it changes to BLACK text. 

Only messages stored in the selected folder are displayed.  The message list area 
displays the following fields: 

Field Description 
U Urgent Flag.  Messages sent to this station from another 

Outpost client can be sent as URGENT.  When these 
messages are received, they are indicated by two RED “!!” 
in the “U” column and the message list displayed in RED. 

See the Message Form for the control to set a message as 
URGENT. 

 

Type Indicates the message’s type and can contain one of the 
following 3 types: 

(blank) Private Message 
B Bulletin 
NTS National Traffic System Message 
DRAFT Message is not complete and not ready to be sent 
 

For received messages, the Message Type is set by the 
sender.  For locally created messages, it is set based on the 
option chosen at the time the message was created. 

 

From The originator of this message.   

This field contains either an FCC Call Sign (current station 
ID) or Tactical Call as assigned by the local emergency 
organization. 

 

To The destination addressee of this message.   

This field contains one ore more of the following types of 
addresses structures: 

 Legal user call sign 
 Hierarchical packet address 
 Tactical Call Sign 
 NTS address 
 SMTP email address (xNOS BBS systems) 
 SMTP:name@domain for Winlink RMS/CMS access 
 +ADDRESS_BOOK entry 
See Section 8 Working with Messages for details 

 

BBS The currently selected BBS. 

For messages created in Outpost, this field contains the 
name of the BBS that was set when the message was 
created, and where this message will be sent.  This allows 
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Field Description 
messages to be created for users on different BBSs, and 
not sent until the BBS is selected using the Setup > BBS 
menu. 

For messages received from the BBS, this field lists the 
BBS from where the message originated. 

 

Local ID Local Message ID. 

Shows the Local Message ID (LMI) assigned to incoming 
messages.  Some jurisdictions require identifying all 
messages – both outgoing and incoming – with their own 
Message ID.  When this option is turned on, the LMI will 
be displayed here.   

This option is controlled from the  
Tools > Message Settings, Msg Numbering tab. 

 

Subject The subject of the message.  On opening the message, the 
entire 128-character subject line is displayed. 

NOTE: most BBS’s have subject lengths that are a lot 
shorter than this.  It is recommended to keep your subject 
lines brief so they inadvertently do not get truncated in a 
manner that you did not anticipate. 

 

Date / Time The Date and Time when the message was Posted on the 
BBS. 

For messages created and saved in Outpost (stored in the 
Draft Folder) or Sent (stored in the Out Tray), this field 
will be set to None. 

After a message is sent to the BBS, it is moved to the Sent 
Folder and the date/time is set to the time the message was 
sent to the BBS. 

For message received from the BBS and stored in the In 
Tray, this field is set to the date/time that the message was 
posted on the BBS. 

For messages received from BBSs that maintain their time 
in GMT/UTC, Outpost converts the time to Local Time 
based on the Time Zone set up on your PC. 

The format of this field is dependent on your PC’s 
Regional and Language Option settings. 

 

Size Size of the message in Bytes as stored in Outpost. 

Outpost has a hard limit of 10,000 characters per message.  
All originated and received messages will be limited to this 
size. 
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3.6 Status Bar 

The status bar is displayed at the bottom of the Outpost Form and displays the 
following information. 

 

Figure 10: Typical Status Bar 

 

 

Figure 11: Status Bar when Tactical Call is enabled 

 
Item Description 
Message Count Displays the number of messages (items) in the 

currently displayed folder and the total number of 
messages in all folders (includes messages in the 
Deleted Msgs folder). 

 

Current Setup Displays the currently selected settings:  Profile Name, 
station call sign, the currently selected TNC, and the 
currently selected BBS.  Selected Tactical Call will also 
be displayed if selected.  See the 2nd example above. 

 

Time until next 
Packet Session 

When Send/Receive automation is selected, this 1st 
timer shows the number of hours, minutes, and seconds 
left until the next Send/Receive Session is initiated. 

If the timer shows 00:00:00, then no automation is 
selected. 

 

Current Time The current system time in 24-hour format. 

 

3.7 Customizing the Display 

Outpost lets you to change the widths of the columns, or hide a column if it is not 
needed for viewing.  

 

Figure 12: Resizing a column 
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To change a column width:  

1. Put the mouse cursor on the right side of a column header’s dividing line for the 
column you want to change size. 

2. Left Click, hold the mouse button down, and move the mouse left to reduce the 
column size or right to increase the column size. 

3. To hide a column, move the mouse all the way to the left until the field is 
hidden. 

4. Double-click on the dividing line will automatically resize the column to the 
widest text in the column. 

There are some column and form re-sizing features on the Tools menu: 

 Reset column widths:  Resizes the columns to a default size. 

 Pack column widths:  Resizes the width of all columns to a width of the 
widest text in each column for the current display. 

 Reset form to normal:  Restores the form to the default position. 

 

Figure 13: Resetting column widths 

3.8 Getting ready to set up Outpost 

In most cases, the steps involved with setting up Outpost need only to be performed 
once.  All setup options are stored in initialization or data files.  There are 4 things 
that must be set up prior to running your first Packet Session.  These are: 

• Select an interface and define the device 

• Configure the BBS 

• Register your call sign with the BBS (BBS-dependent) 

• Confirm your user settings on the BBS 

In preparation for defining these configurations, it is helpful to have any hardware 
and BBS documentation that may be available.  If none can be found, manually 
interacting with the TNC and the BBS is the next best way to confirm you have 
entered these configurations correctly.   

In most cases, the default Outpost settings can be used when defining a TNC or 
BBS.  However, there is some information that is TNC and BBS specific that must 
be understood in order to complete the setup step. 

These items are covered over the next 2 sections in this guide.   
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4 Setting up Interfaces 
 

Outpost can communicate with a BBS by one of three methods: direct serial port 
with a TNC, an AGWPE-controlled TNC or other device, or by a telnet connection.  
Setting up your interface is the first step that you must do. 

4.1 Defining the Interface Type 

Depending on the type of interface that you select, the corresponding tabs will be 
enabled.  In the example below, the Device Type is a TNC that is connected to one 
of the PCs Serial Ports or a USB-to-Serial adaptor.  Note that the AGWPE and 
Telnet tabs are disabled. 

Outpost comes with examples of different interfaces already set up.  Please use 
these as examples when picking and defining a new interface. 

 

Figure 14: Interface Type Setup 

Device settings are managed from the 6 tabs across the top of the Interface menu.  
These tabs are: 

Tabs Description 
Interface Type Allows the user to define a new interface or select a 

previously configured interface. 
 

TNC Prompts Enabled for a TNC connected to a Serial Port.  This tab 
holds the definitions of what the TNC prompts look like.  
Defaults are specific for the KPC3 TNC, and generally 
work for all others. 
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Tabs Description 
TNC Commands Enabled for a TNC connected to a Serial Port.  This tab 

holds the definitions of the different commands Outpost 
uses to talk to the TNC. 

This tab also contains the controls for managing a TNC 
Initialization file that you may define for this device.  
This is covered later in this section. 

TNC Comm Port Enabled for a TNC connected to a Serial Port.  This tab 
contains the serial port configurations for this TNC. 

 

AGWPE Enabled for an AGWPE interface.  This tab contains the 
parameters needed for Outpost to talk to the AGWPE 
monitor program.   

 

Telnet Enabled for a Telnet interface.  This tab contains the 
parameters needed for Outpost to talk to the BBS that is 
Telnet-accessible. 

 

 

On the Interface Type Tab, the following fields are available: 

Fields Description 
Device Name A Pull-down menu of the interfaces previously set up in 

Outpost.   

Default: Last interface type selected. 
 

Device Name When creating a new interface entry, the Pull-down tab is 
hidden and a fill-in-the-blank Device Name field is enabled 
so you can enter the name of a new TNC or interface.  

While this is usually the TNC Model Number (i.e.: KPC-3), 
it can be some other friendly description such as KPC3-P0 
(port 0), JIMS-KPC3+, etc. 

The name can be up to 64 characters long. 

 

Description This is an optional free-form text field for entering any 
information about this TNC or interface.   

This is a 256 character field. 

 

Device Type Selects or displays the device type for the interface.  When 
creating a new entry, the user picks the interface type they 
want to set up. 

Default: TNC  
 

 

The following menu controls are available: 

Controls Description 
New Lets the user set up a new interface type.  All fields 

throughout the menu are either cleared or set to their default 
settings. 
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Controls Description 
Copy Allows the user to copy or Clone the currently displayed 

interface.  When pressed, the name of the current device is 
used along with the words “COPY OF” appended to it to 
ensure it is a unique name and the form is put into the New 
TNC mode for editing and updating.  This name can then be 
changed, along with the other fields for this device. 
 

Delete Lets the user delete the currently displayed TNC or 
interface.  The user will prompted whether they really want 
to delete the interface. 
 

OK Same as Apply, but closes the menu on completion if the 
validation is successful. 
 

Apply Causes all required fields to be validated as being filled in.  
On completion, the menu remains open.  The Apply button 
becomes enabled as soon as any field is changed by an 
update to an existing configuration or by defining a new 
interface. 
 

Cancel Cancels any changes that may have been made to the form, 
and the form is closed. 
 

4.2 Serial Port TNC Setup 

A “Terminal Node Controller” (TNC) connects your computer to your radio, similar 
to how a dial-up modem connects your computer to the Internet by telephone.  Most 
TNCs implement some or all of the command-set defined by TAPR (Tucson 
Amateur Packet Radio Club).  Outpost uses these commands as the default 
commands when setting up your TNC.  If your TNC’s command-set is different, 
you can change them when you define a new or update an existing TNC. 

 

Figure 15: TNC Setup Menu 
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There are 3 tabs that are enabled to define the Serial Port TNC. 

The TNC Prompts menu contains information on the prompts that the TNC will 
send back to Outpost so Outpost knows what kind of response it got from the TNC.   

On creating a new TNC, the default prompts are loaded as shown below, and should 
work fine for all TNCs.  Check your TNC manual if a system hang occurs. 

 

Figure 16: TNC Prompts Setup Menu 

The fields on this form are: 

Fields Description 
Command The prompt that the TNC displays to prompt for the next 

TNC command.   

Default: cmd:  (TAPR standard prompt) 

 

Timeout The string that is displayed by the TNC when the number of 
configured retries is exceeded.  Outpost uses this message 
to detect a timeout and cancel the session. 

Default: *** retry count exceeded 

 

Disconnected The string that is displayed by the TNC whenever the TNC 
unexpectedly disconnects from the BBS.  This is usually 
caused if the BBS terminates the connection, or the user 
forces a disconnect.  Outpost uses this message to detect 
this condition and attempts to cleanly exit the session. 

Default: *** DISCONNECTED 

 



Outpost Packet Message Manager v2.7 
Users Guide 

January 15, 2013 29

The TNC Commands menu contains the different commands that Outpost uses to 
talk to the TNC to prepare for and connect to the BBS.  On creating a new TNC, the 
default commands are loaded, and should work FINE for MOST TNCs.  Check 
your TNC manual if a system hang occurs. 

 

Figure 17: TNC Commands Setup Menu 

The fields on this form are: 

Fields Description 
Mycall The TNC command that is used to set the station ID.  When 

entering this command, only enter the TNC portion of the 
command.  Do not include your call sign. 

Default: my (short for MYCALL) 

  
Connect The TNC command that initiates a connection with a BBS.  

When entering this command, only enter the TNC portion 
of the command.  Do not enter the BBS callsign.   

Default: connect. 

 
Retry The TNC command that sets the number of attempts the 

TNC will transmit a packet to the BBS before giving up. 

Default: retry 

 
Converse 
Mode 

The TNC command that puts the TNC into a converse 
mode.  This is used when Tactical Calls are used. 

Default: reset 
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Fields Description 
DateTime The TNC command that is used to set the TNC’s date and 

time.  This command is transmitted each time a Packet 
Session is initiated.  If this field is left blank, no date/time 
command is sent to the TNC. 

Default: daytime 

 

TNC Command Prefix.  Some TNCs require a specific character to be set with 
TNC commands to differentiate it from a string to be transmitted.  For instance, the 
SCS Tracker Modem requires the <esc> escape character to precede all commands 
sent to the TNC. 

Controls Description 
Include TNC 
Cmd Prefix  

When Unchecked, no TNC command prefix character is 
sent.  When Checked, the integer representing the character 
to be sent (i.e.: 27 = Escape). 

Default: unchecked 

 

 

A TNC Initialization File can be defined that contains other TNC Commands that 
Outpost usually does not send.   

In reality, you would want to set up some TNC commands if you also use other 
packet programs that do not always “clean up” after themselves in terms of resetting 
the TNC to a known state.   

The controls on this form are: 

Controls Description 
Send TNC 
command 
File…  

Option: File not Defined 

If this label (File not Defined) is presented as an option, 
then an Initialization Command File is not defined for this 
TNC.  This label will change depending on whether a TNC 
Initialization Command File exists or not. 

Option: Never 

If this label (Never) is presented as an option, then an 
Initialization Command File is defined for this TNC.   

Check this option if you do not want to send this file to the 
TNC. 

Option: During every Send/Receive Session 

If this option is enabled (not grayed out), then an 
Initialization Command File is defined for this TNC.   

Check this option if you want to send this file to the TNC 
every time you connect to the TNC. 

 

Create / 
Update File 

This control opens the form where the user can enter 
additional TNC initialization commands. 
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Figure 18: TNC Initialization Commands File Form 

Once the Create/Update file is opened, you can enter TNC commands to be 
executed at either the beginning or the end of a Send/Receive Session. 

The fields on this form are: 

Fields Description 
Commands 
to send 
before… 

Commands entered in this section will be sent after Outpost 
sends it standard set of commands and before connecting to 
the BBS. 

Enter a single command on each line. 

 

Commands 
to send 
after… 

Commands entered in this section will be sent after Outpost 
disconnects from the BBS and before disconnecting from 
the Comm Port. 

Enter a single command on each line. 

 

 

There are 2 controls for this form.   

Controls Description 
Save Saves the Command set to the file named:  

<tnc_name>.ini, where tnc_name is the name of the TNC 
associated with this setup. 

 

Cancel Closes the form without saving any entries. 
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The TNC Comm Port menu defines the serial port settings for the TNC.  On 
creating a new TNC, an initial configuration is loaded, but should be carefully 
checked against the serial port configuration for the TNC you are using.   

 

Figure 19: TNC Comm Port Setup Menu 

 

Comm Port settings are standard serial port settings typically used by other terminal 
emulator programs.  These settings define: 

Fields Description 
Port Identifies the Serial Port to which the TNC is connected.   

Outpost will detect the list of available ports on your PC, 
whether true Serial Comm port or a USB-to-Serial Port 
adaptor. 

Default: first Comm Port found if creating a new entry, or 
the Comm Port entered when set up. 
 

Max Speed This is the baud rate between the computer and the TNC.  
This is different from the speed that the TNC transmits data 
to the BBS.  Outpost Baud Rate settings include: 

110  19200 
300  28800 
600  38400 
1200  56000 
2400  57600 
4800  115200 
9600  128000 
14400  256000 

Default: 9600 
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Fields Description 
Data Bits The number of data bits to be sent.   

Default: 8 
 

Parity Defines how parity will be handled  

Default: None 
 

Stop Bits Default: 1 
 

Echo This setting is disabled and cannot be changed. 

Default: On 
 

Flow Control Determines how the program will manage the data flow 
between the Computer and the TNC.  The following options 
are available: 

None:  no flow Control is used 
RTS/CTS: Hardware flow control 

Default: RTS/CTS 
 

 

Comments on Flow Control 

Flow Control (also known as Handshaking) is a way for data communication 
equipment to control the flow of data between connected equipment, particularly 
when one part of the system is slower than the other.  This is the case with the TNC 
and BBS.  While the PC running Outpost can connect and transfer data to the TNC 
at a high data rate (such as 9600 baud in the example above), the TNC is limited to 
transmitting at 1200 baud (or 9600 baud if your radio and BBS supports it) with the 
BBS.  

Because Outpost generates all the commands that you would typically enter, it 
communicates with the TNC at a significantly faster rate than what you could 
manually type.  Therefore, there is the risk that Outpost will overflow the TNC’s 
internal transmit data buffer.  When this happens, the TNC and the Packet Session 
Manager will hang. 

The default setting is RTS/CTS (Hardware Flow Control).  For this option to work, 
you must have a serial cable between the TNC and Computer with at least the 
additional CTS pin connected.  To make it easy, I recommend using a full 9 pin 
cable.  If you have only a Pin 2 and 3 cable, leaving this setting as is will not have 
any adverse effect.  However, no flow control will occur and you should keep your 
messages as short as possible to avoid overflowing the TNC’s transmit data buffer. 

WARNING!  Unshielded home-made cables are a known source of problems that can cause 
system and PC hangs.  Most commercial cables are shielded.  If you decide to make 
your own, ensure the cable is shielded, or else RF will get into your computer. 
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4.3 AGWPE Setup 

Per Ralph Milnes KC2RLM, “AGWPE is a multi-TNC management utility written 
by George SV2AGW.  Before AGWPE, a packet device such as a TNC or other 
radio modem could only be used by one program at a time.  Likewise, a packet 
program could only use one packet device at a time.  AGWPE changed all that.  It 
lets a program access multiple packet devices at one time, and lets a packet device 
be shared by multiple programs at one time. 

“AGWPE performs this magic by placing the TNC in KISS mode and assuming 
responsibility for handling most of the logic functions built into the TNC.  The TNC 
is left to handle just tone modulation/demodulation, or modem functions. AGWPE 
also works with radio modems, such as the YAM and Baycom that already lack 
logic functions and must rely on the logic functions of a control program such as 
AGWPE.” 

NOTE:  For users wishing to use AGWPE, I strongly recommend that you thoroughly 
understand how AGWPE works, how it is set up, and how it is confirmed 
operational before deploying it with Outpost.  AGWPE support is a field of study 
unto itself and therefore, is out of scope for Outpost support.  However, there is 
plenty of help available from users on the Internet. 

Outpost implements the required protocol to talk to AGWPE and its associated TNC 
device located either on the same PC where Outpost is running or on a remote PC 
somewhere else on the network. 

The AGWPE setup form is enabled once AGWPE is selected as the device type. 

 

 

Figure 20: AGWPE Setup Menu 
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The AGWPE menu manages information specific for accessing the AGWPE 
program.  On defining a new AGWPE Interface, the default values shown above are 
loaded, and should work for a locally configured (same PC) AGWPE installation.  
The fields on this form are: 

Fields Description 
Remote Host The IP Address or host name of the PC where AGWPE is 

running.  The default setting tells Outpost to look for the 
AGWPE on the local machine where Outpost is running. 

Default: 127.0.0.1 

 
Remote Port Ports are used with TCP to name the logical connection on a 

specific network node.  This setting must match what is set 
up in the AGWPE Winsock Interface form. 

Default: 8000 (matches AGWPE’s default port number) 

 

Network 
Timeout 

The network timeout tells Outpost how long to wait for a 
network interaction with AGWPE before giving up and 
reporting an error.  A setting of 5000 milliseconds  
(5 seconds) is plenty, particularly if AGWPE is operating 
on the same PC as Outpost. 

For remote instances of AGWPE, the timeout may need to 
be longer depending on the network traffic. 

Default: 5000 

 
TNC 
RadioPort 

Corresponds to the TNC Radio Port setting defined on the 
AGWPE Radio Port TNC Setup 

Default: 1 

 
AGWPE 
Logon 
Required 

This and the next 2 fields depend on whether a logon 
requirement was defined at the AGWPE program.   

For AGWPE operating on the same PC as Outpost, no 
Logon is required.  Logon is optional for cases where 
AGWPE is located somewhere else on the same LAN, or 
elsewhere on the internet. 

Check this box is a Logon is required. 

Default: unchecked (not required) 

 
Logon If the AGWPE Logon box is checked, this field is enabled.  

The logon name entered here must match the name set up in 
AGWPE. 

Check the AGWPE configuration for a Logon/password 
requirement (AGWPE’s Winsock Interface Security tab). 

Default: no entry 

 
Password If the AGWPE Logon box is checked, this field is enabled.  

The password entered here must match the name set up in 
AGWPE. 

Check the AGWPE configuration for a Logon/password 
requirement (AGWPE’s Winsock Interface Security tab). 

Default: no entry 
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4.4 Telnet Setup  

There are some BBSs that can be accessed by Telnet. 

Similar to the AGWPE, setting up telnet requires an understanding of the network 
settings that need to be defined.  Unlike AGWPE, Telnet access to a BBS is usually 
more tightly controlled resulting in the need to work with the BBS Sysop to 
establish a telnet logon and password.  This ensures non-Hams cannot initiate traffic 
on the Amateur Radio bands. 

The Telnet setup form is enabled once Telnet is selected as the device type. 

 

Figure 21: Telnet Setup Menu 

The Telnet menu contains information specific to accessing the remote BBS over a 
LAN or WAN.  On defining a new Telnet Interface, some default values are loaded, 
but will be insufficient to operate without additional information.   

The fields on the form are: 

Fields Description 
Remote Host The IP Address or host name of the server where the BBS is 

running.  The default setting tells Outpost to look for the 
BBS on the machine where Outpost is running.  Contact the 
BBS Sysop for the IP Address or host name. 

Default: 127.0.0.1 

 
Remote Port Ports are used with TCP to name the logical connection on a 

specific network node.  Contact the BBS Sysop for the Port 
number. 

Default: 23 

 
Network 
Timeout 

The network timeout tells Outpost how long to wait for a 
network interaction with the BBS server before it gives up 
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Fields Description 
and reports an error.  A setting of 5000 milliseconds  
(5 seconds) is plenty, particularly if the server is operating 
on the same LAN as Outpost.  

For remote instances of the server, the timeout may need to 
be longer depending on the network traffic. 

Default: 5000 

 
Logon 
Prompt 

This is the string presented by the BBS that prompts for the 
Logon Name.  This entry must match exactly what the BBS 
sends as a logon prompt.  Watch the spaces and 
capitalization. 

Default: Callsign : 

 
Password 
Prompt 

This is the string presented by the BBS that prompts for the 
password.  This entry must match exactly what the BBS 
sends as a password prompt. Watch the spaces and 
capitalization. 

Default: Password : 

 
Logon This will be your answer to the Logon Prompt that will be 

sent.  Contact your BBS Sysop for the logon information.  
Usually, this will be your call sign. 

Default: no entry 

 
Password This will be your answer to the Password Prompt that will 

be sent.  Contact your BBS Sysop for the logon 
information.  This will be set up by the Sysop. 

Leave this field BLANK if there is no password assigned to 
access the BBS by Telnet (not recommended). 

Default: no entry 

 

 

The controls on the form are: 

Controls Description 
Use Station 
Identifier… 

Use Station Identifier for Telnet Logon. 

When checked, the Logon Name that is passed to the BBS 
will come from the Station Identification Form instead of 
this form (Logon Name field).  This simplifies changing 
users without needing to change the Telnet interface as 
well.  

Default: unchecked 

 
Telnet 
Transparency 
Mode 

Telnet (WL2K) Transparency Mode. 

There are some BBSs – Winlink CMS in particular – that 
requires a connection in Telnet Transparency Mode. 

If you are connecting to a Winlink CMS node by Telnet, 
check this box.  Otherwise, telnet will not work. 

Default: unchecked 
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4.5 Selecting a previously configured interface 

If you decide to install the sample Outpost configurations, you can see some 
commonly available TNCs, and sample AGWPE and Telnet interfaces already 
configured.  To select one of these configured TNCs, perform the following:  

1. From Outpost’s main form, select the Setup > TNC…  If a TNC was 
previously defined, it will be displayed. 

2. At the TNC Name: field, use the pull-down menu to view the previously 
configured TNCs. 

3. Select the TNC you want to use.   

4. Press OK when done.  This TNC is now selected as the default TNC. 

When done, Outpost will display the selected TNC on the Status Bar on the bottom 
of the Main Form.  

 

Additionally, a previously used BBS-and-Interface pair can be selected from the 
File Menu’s most recently used list.  This lists all the combinations that were 
previously selected in order when they were used, most recent on top. 

 

4.6 Updating a previously configured Device 

Most TNC settings can be changed.  To change a TNC setting, do the following:  

1. From Outpost’s main form, select the Setup > TNC…  If a TNC was 
previously defined and selected, it will be displayed and loaded. 

2. All fields (other than the TNC name) can be changed.  When done, press 
Apply or OK. 
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4.7 Defining a new interface 

Setting up a new Interface uses the menus described above.  Depending on the 
interface selected will determine which tabs on the menu will be enabled.   

Set up a new TNC as follows: 

1. From Outpost’s main form, select the Setup > TNC… 

2. Press the New button. 

3. Enter the Device Name.  A good rule of thumb is to enter the product or 
model number for a TNC (such as KPC-3, KAM, DSP232, etc.), or some 
descriptive text for AGWPE or Telnet (such as AGWPE-LOCAL, 
TELNET-TO-CRAIG).  Device names can be up to 64 characters long. 

4. Enter any additional text in the description field you want about the TNC 
(i.e.: location, etc). 

5. For Serial Port TNC setups, the TNC commands are generally the same 
from one TNC manufacturer to another. 
 
Having said that, undoubtedly there is one or more TNCs on the market that 
have a different command and/or prompt set.  Because Outpost issues TNC 
commands on behalf of the user, and looks for the TNC prompts coming 
back, it is important that the specific TNC commands and prompts required 
by Outpost are defined.  If your TNC has a different command-set or 
prompt-set from what is initially loaded, then you will have to change the 
default settings. 

6. For Serial Port TNC setups, using the TNC’s reference manual, verify the 
default TNC prompts are correct, or change them as necessary. 

7. Verify the default TNC commands are correct, or change them as necessary.   

8. Verify the Comm Port settings are correct, or press the Comm Port button 
to change them as necessary (see below for the Comm Port menu). 

9. Press OK when done.  This new TNC entry and Comm Port settings are 
saved and set as the current TNC. 
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5 Setting up a BBS 
 

The next step with setting up Outpost is to identify the Bulletin Board System 
(BBS) you want to access. 

5.1 History 

Wikipedia defines it the best: “A Bulletin Board System, or BBS, is a computer 
system running software that allows users to connect and log in to the system using 
a terminal program.  Once logged in, a user can perform functions such as 
uploading and downloading software and data, reading news and bulletins, and 
exchanging messages with other users, either through electronic mail or in public 
message boards. 

“Originally BBSes were accessed only over a phone line using a modem, but by the 
early 1990s some BBSes allowed access via a Telnet, packet switched network, or 
packet radio connection. 

“The term "Bulletin Board System" itself is a reference to the traditional cork-and-
pin bulletin board often found in entrances of supermarkets, schools, libraries or 
other public areas where people can post messages, advertisements, or community 
news.” 

It is the “exchange of messages with other users” feature on which Outpost relies.  
For our purposes, a BBS is simply a mail drop for packet messages.  Packet BBSs 
come in all different types and sizes with implementations in both hardware 
(Personal BBSs as implemented in a TNC) and software, operating as either stand-
alone or networked with packet messages shared across BBSs.   

Because not all BBSes operate the same way, Outpost explicitly needs to know how 
the BBS works to correctly access it.  Today, Outpost supports the following BBS 
and PBBS systems: 

 

Firmware-based 
PBBSs 

KPC2, KPC2400, KPC3, KPC3+, KPC9612 
KAM, KAM-XL, KAM-98 KAM Plus, KAM-4 
Kantronics’ Data Engine 
PK-88, PK-96, PK-232, DSP-232  
MFJ-1270x, MFJ-1274, MFJ-1278 

Software-based 
BBSs 

AA4RE 
BPQMailChat 
DXNET 
F6FBB 
HAMSERV 
JNOS, SNOS, TNOS 
MSYS 
N0ARY 
NNA 
OpenBCM 
Winlink RMS, CMS 
W0RLI 

 

“Support” means that Outpost knows how to identify the BBS using its System 
Identifier, determine the BBS prompt, and how to interpret the Message Listing 
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resulting from a LM, LB, or LT.  For BBSs not listed here, see the BBS portion of 
the Outpost website for instructions and criteria on getting your BBS supported. 

5.2 BBS Setup Menus 

Outpost comes with some examples of different BBSs already set up.  Please use 
these as references when setting up a new BBS. 

 

Figure 22: BBS Setup Menu 

BBS settings are managed from a series of tabs across the top of the above menu.  
These tabs are: 

 

Tabs Description 
BBS Name Allows the user to select a previously defined BBS, or 

define a new one. 
 

BBS Prompts Allows the user to enter the BBS prompts instead of 
letting Outpost figure them out. 

 

BBS Commands Contains the entries for the different commands that 
Outpost uses to talk to the BBS. 

 

BBS Path Contains the options for selecting the method of 
connecting to the BBS: direct, digipeating, or by KA or 
Netrom Nodes. 
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On the BBS Name Tab, the following fields and controls are available: 

Fields Description 
BBS Name A pull-down menu containing the list of friendly names that 

identify the BBSs currently set up in Outpost.  Friendly 
names allow different configurations to be entered for the 
same BBS.   

Default: Last BBS selected  
 

Connect 
Name 

The exact name of the BBS to which you want to connect.  
This is NOT a friendly name (Bob’s BBS) but the call sign 
and SSID (if used) of the BBS, such as K6FB-2 or an alias 
(SEABBS).  This is the string that will be added to the TNC 
“connect” command. 

Default: blank  Character Size: 10 

 

Description This is an optional free-form text field for entering any 
information about this BBS. 

Default: blank  Character Size: 256  
 

BBS Type Outpost supports 4 options on how to configure the BBS. 
1. Let Outpost determine the BBS and set up the 

prompts 

Outpost will identify the BBS based on the BBS’s 
System Identifier (SID) or other unique sign-on 
introduction.  It will then determine the BBS prompt by 
looking for the first occurrence of the “>” character, 
and then look back at the preceding line of text to 
determine the BBS command prompt.  When this 
option is selected, the 2nd tab (BBS Prompts) is 
disabled.  

2. User defines the BBS prompts 

The user has the option of setting up the prompts 
directly.  This implies a more detailed working 
knowledge of how the BBS works.  This option would 
be chosen because of some mitigating situation where 
Outpost could not determine the BBS prompt correctly.  
In general, do not check this option. 

3. AA4RE BBS 

This BBS is a non-identifying BBS, meaning, it does 
not identify with an SID.  Checking this box ensures 
Outpost knows this BBS is an AA4RE.  However, the 
user needs to know this.  See the list of supported BBSs 
on the Outpost website to compare the BBS message 
listing to confirm what you have is really an AA4RE 
BBS. 

4. AA4RE BBS with Tactical Call Customization 

This is a modified version of the AA4RE BBS that 
prompts for a tactical call.  The only known instance 
was with Santa Clara County RACES (subsequently 
decommissioned).  In general, do not check this option. 

Default: Let Outpost determine the BBS… 
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The following menu controls are available: 

Controls Description 
New Allows the user set up a new BBS.  All fields are set to their 

default settings. 

 

Copy Allows the user copy or Clone the currently displayed BBS.  
When pressed, a copy of the currently displayed BBS is 
made, the Friendly Name is the current BBS with the words 
“COPY OF” appended to it, and the form is put in New 
BBS mode for updating and editing.  This name can then be 
changed, along with the other fields for this device. 
 

Delete Allows the user delete the currently displayed BBS.  The 
user will be prompted whether they really want to delete the 
BBS. 

 

OK Same as Apply, but closes the form on completion if the 
validation is successful. 

 

Apply Causes all required fields to be validated as being filled in.  
On completion, the menu remains open.  The Apply control 
becomes enabled as soon as any field is changed as caused 
by an update to an existing configuration or by creating a 
new BBS.   

 

Cancel Cancels any changes that may have been made to the form. 
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The BBS Prompts tab is disabled for all BBS type selections except for the 2nd 
choice: User defines the BBS prompts.  This form normally will be blank and 
disabled (labels and data fields) for all other BBS Type options. 

 

Figure 23: BBS Prompts Menu 

The fields on the form are as follows: 

Fields Description 
BBS 
Command 
Prompt 

The prompt that the BBS displays to prompt for the next 
BBS command. 

There is no standard BBS prompt.  It you elect to custom 
define the BBS prompts, it is recommended that you copy 
the BBS prompt exactly so there is no mistake in its setup. 

Default: none 

Use default… 
after Outpost 
sends a 
message 

After Outpost sends a message to the BBS, Outpost will 
looks for the string identified here and sent from the BBS to 
know that the message was sent. 

NOTE: Do not override this unless you are very sure of 
what the BBS sends back under this condition. 

Default: CHECKED, value defaults to the command 
prompt if one entered in the BBS Command Prompt field. 

Use default… 
after Outpost 
receives a 
message 

After Outpost receives a message from the BBS, Outpost 
will looks for the string identified here and sent from the 
BBS to know that the BBS is finished sending. 

NOTE: Do not override this unless you are very sure of 
what the BBS sends back under this condition. 

Default: CHECKED, value defaults to the command 
prompt if one is entered in the Command Field. 
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WARNING!  Changing the last 2 fields may result in unexpected results.  Be very careful if you 
decide to change these values. 

The BBS Commands tab contains the commands that Outpost issues to the BBS 
to send, list, receive, and delete messages on the BBS.  On creating a new BBS, the 
default prompts are loaded, and should work fine for most BBSs.  

 

Figure 24: BBS Commands Menu 

The fields on the form are as follows: 

Fields Description 
Send Private The BBS command that is used to send a Private Message.  

Only the station to which this message is addressed can read 
it. 

Default: SP 

NOTES for JNOS Users:  If the message is created with 
multiple addresses in the TO: field, then the message is sent 
with the “SC” command (send with copies).  This lets only 
one message to be transmitted to all addressees. 

 

Send Bulletin The BBS command that is used to send a Bulletin Message.  
Bulletins are usually addressed to a group of stations.  All 
stations can read bulletins.   

Default: SB 

 

Send NTS The BBS command that is used to send an NTS Message.  
NTS messages can be read by anyone who is willing to 
service the NTS message.   

Default: ST 
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Fields Description 
List Mine The BBS command that that produces the list of messages 

addressed to you (your call sign or tactical call sign). 

Default: LM 

 

List Bulletin The BBS command that produces the list of bulletins 
present on the BBS. 

Default: LB 

 

List NTS The BBS command that that produces the list of NTS 
messages present on the BBS. 

Default: LT 

 

List Filtered The BBS command that will produce the list of messages 
that match the Filter Masks defined on the Send/Receive 
Settings menu. 

Default: L>  

NOTE for JNOS:  For JNOS users, if this field is set to 
“L” only, then only new messages to be listed. 

 

Read 
Message 

The BBS command that retrieves and displays a specific 
message on the BBS. 

NOTE:  Do not replace this with the RM (Read Mine) 
command.  Outpost uses the R ### command to explicitly 
read and handle one message at a time. 

Default: R 

 

Delete 
Message 

The BBS command that deletes a message on the BBS. 

Default: K 

 

Bye/Log off The BBS command that logs you off of the BBS. 

Default: B 
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The BBS Path tab is used to define how Outpost will reach the BBS. 

 

Figure 25: BBS Path Menu 

The following menu controls are available: 

Controls Description 
Access 
Method 

One of three methods can be selected for accessing the BBS 
over an RF path: 

1. Direct to BBS.  This option means that Outpost will 
connect directly to the BBS without any intermediate 
nodes or stations in the signal path. 

2. Via Digipeater(s).  The user cannot reach the BBS 
directly and needs to use one or more digipeat stations 
that may exist between the user and the BBS.  When 
selecting this option, the corresponding field is enabled 
for input.  Multiple Digipeat stations can be entered and 
separated by commas. 

3. KA-NODE/Netrom Access.  Similar to the Digipeat 
option, the user chooses to use KA- or Netrom nodes to 
reach the BBS.  When this option is selected, the 
“Create/Update Path” button is enabled and allows the 
user to enter the information for each node in the path. 
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5.3 Configuring for KA-Node/Netrom access 

Configuring for KA-Node/Netrom access is not difficult, but does require an 
attention to detail to get the settings right.  Once you select this access method, the 
Create/Update Path button is enabled and a configuration must be created before 
this BBS configuration can be saved.  Once this button is pressed, the Node Path 
Setup form is displayed. 

NOTE:  See the Application Note titled “Setting up KA-Node/Netrom Network Access” on 
the Outpost website for a more detailed walk-through of this topic. 

 

Figure 26: Node Path Setup 

The fields on the form are as follows: 

Fields Description 
Node Name The actual connect name of a node in the node path, such as 

K6FB-7 or W6TDM-7. 

Default:  blank 

 
Successful 
Connect 
Message 

The string that is returned by the node indicating that you 
are connected.  Outpost uses this string to confirm that the 
connection was successful, and is ready to either connect to 
the next node in the sequence or connect to the BBS. 

Default:  blank 

 
Connect cmd 
to the next 
node/BBS 

Some nodes support multiple channels that allow you to 
connect to a different channel.  While the “C” connect 
command is typical, other commands could be used, such as 
“X” for Xconnect (cross-connect), or “BBS”. 

Default:  C 
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Fields Description 
Connect with 
node/BBS 
name 

Some nodes are actually the host access point to a local 
BBS and does not require a full “c bbs_name” as the final 
command.  Instead, by setting up the previous field as 
“BBS” connects the user directly to the BBS. 

NOTE: This is network- and BBS-dependent. 

Default:  CHECKED 

Port Number The port number to be taken from the current node to the 
next node.  Some nodes have multiple radio ports typically 
set up on different bands. 

For single channel ports, leave this value as 0. 

Default:  0 

Unsuccessful 
Connect 
Message 

In the event the connect request to the next node was 
unsuccessful, this string is returned by the current node to 
tell Outpost that the next connect was not successful. 

Default:  blank 

 

The following menu controls are available on this form: 

Controls Description 
Next Retrieves the next previously configured node in the 

sequence when there are more than one nodes in the node 
list. 

 

Previous Retrieves the previous node in the sequence when there are 
more than one nodes in the node list. 

 

Add Clears the form and prepares to receive information about a 
new node.  All new nodes are added to the end of the node 
list. 

 

Delete Deletes the displayed node from the node list. 

 

Move Up Moves the displayed node up earlier (sooner) in the 
sequence.  This is typically used when an intermediate node 
is added.  All new nodes are added to the end of the list and 
may need to be positioned sooner in the list. 

 

Move Down Moves the displayed node further back (later) in the 
sequence.  
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Configuring a Node Path 

To configure any node path, perform the following steps: 

1. Collect information about the path to the BBS 

2. Perform the connection manually before starting any Outpost setup 

3. Record the relevant information for each node that you will need for the 
Outpost setup 

4. Configure Outpost (and your BBS) for Node access 

5. Test the configuration 

 

Considerations about using Node Path 

 Your understanding of the node path to get to the BBS is critical.  I recommend 
developing a worksheet that includes the following: 

 

Node # Node Name Successful Msg Connect 
command 

Connect 
with name 

Port Unsuccessful Msg 

1 K6KP-7 Help ? C checked 0 ###RETRIED 

2 W6TDM-3 ###LINK MADE C checked 0 3} Failure with 

3       

 

 To develop the Successful Connect Messages, manually run through the 
sequence and record what each node returns.  Usually, only the last couple of 
characters in the string are required.  For instance, for Node 1 above, the entire 
returned string was: “ENTER COMMAND: B,C,J,N, or Help ?”.  However, 
only the “Help ?” is all that is needed.  As usual, watch the spaces and 
capitalization. 
 
Most Netrom nodes do not return anything after a successful connect.  However 
the calling station does report that the link was made (Node 1 was a KPC3 KA-
Node and returned the string: ###LINK MADE).  This string is a suitable proxy 
for the Netrom connect string.  See Node #2 above. 

 To develop the Unsuccessful Connect Messages, you will have to manually 
force the error by entering a non-existent node and recording what is returned.   
 
When picking the error string, DO NOT pick any portion that includes a call 
sign since this may change at runtime.  For Node #2 above, the first portion of 
the error message was picked up and was deemed to be unique regardless of the 
next station to which it tried to connect. 

NOTE:  See the Application Note titled “Setting up KA-Node/Netrom Network Access” on 
the Outpost website for a more detailed walk-through of this topic. 
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5.4 Selecting a configured BBS 

If you decide to install the sample Outpost configurations, you can see some BBSs 
already configured that are mostly found in San Francisco’s South Bay Area.  For 
those Outpost users outside the Bay Area, please use these as examples on how a 
completed BBS setup should look.  If desired, these BBS entries can be deleted 
from the list. 

To select a previously configured BBS, perform the following: 

1. Select Outpost’s Setup > BBS… 

2. At the BBS Name field, use the pull-down menu to view the previously 
configured BBSs.  If a BBS was previously defined, it will be displayed. 

3. Select the BBS you want to use.   

4. Press OK when done. 

Outpost will display the selected BBS on the Status Bar on the bottom of the Main 
Form. 

 

Additionally, a previously used BBS-and-Interface pair can be selected from the 
File Menu’s most recently used list.  This lists all the combinations that were 
previously selected in order when they were used, most recent on top. 

 

5.5 Setting up a new BBS 

Before beginning, you are strongly encouraged to ensure you can access the BBS 
from either the Outpost’s Interactive Packet Program or some other TNC program 
to verify the path and confirm it works before trying it with Outpost. 

Set up a new BBS as follows: 

1. Select Outpost’s Setup > BBS…, then press the New button. 
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2. Enter a Friendly Name.  This is the name that you can use to identify the BBS.  
It can be the BBS call sign (K6FB-2), personal reference (Bobs JNOS), or other 
description that you wish to use.  

3. Enter the Connect Name.  This is the exact name of the BBS as you would type 
it to initiate a connection (such as: K6FB-2, W6XSC-1, etc.).  

4. Select the BBS Type.  The recommended option is the default option: “Let 
Outpost determine the BBS…” 

5. If you cannot reach the BBS from your station, on Tab 4 “BBS Path”, choose 
the path option based on the types of stations between you and the BBS.  

 For Digipeater access, check this box and enter one or more digipeater 
stations (limit is 128 characters / about 9 digi-stations… worst case).  

 For KA-, Netrom Node access, see the Application Note titled “Setting up 
KA-Node Network Access” on the Outpost website for setup details. 

6. Verify the default BBS commands listed; change them as necessary.   

7. Press OK.  This new BBS entry is saved and set as the current BBS. 

5.6 BBS Registration 

The typical Outpost Packet Session assumes there are no superfluous prompts such 
as prompting for the user’s name, zip code, city, etc.  However, some BBSs require 
this as part of the registration process the first time you log on. 

 If you intend to access a BBS that requires registration, you must log on 
manually and register prior to running Outpost. 

 If you run Outpost and the program hangs because of registration prompts, Press 
the Abort Session button, wait for Outpost to end and close the Packet Session 
Manager window, then manually connect to and register with the BBS using 
either Outpost’s Interactive Packet Program (under the Tools > Interactive 
Packet menu) or some other terminal emulator program.   

 Log on manually to confirm the registration was successful. 

5.7 BBS Expert User Mode 

Several BBSs provide different levels of prompts.  

 The NEWUSER mode presents different prompts that guide the new user 
through the use of the BBS. 

 The EXPERT mode assumes the user is familiar with the BBS and its 
commands, and presents only the BBS Command prompt. 

Outpost only works in EXPERT Mode and does not expect to see any other prompt 
other than the BBS command prompt.  If your BBS supports it, before beginning an 
Outpost Packet Session, verify your logon is set for EXPERT. 

See the Outpost Website for specific commands that will help put you in Expert 
Mode and turn off Paging. 

 



Outpost Packet Message Manager v2.7 
Users Guide 

January 15, 2013 54

 



Outpost Packet Message Manager v2.7 
Users Guide 

January 15, 2013 55

6 Setting up Profiles 
6.1 Introduction 

Most of Outpost’s configuration settings are stored in an initialization file.  Version 
2.7 introduces the concept of Profiles that are essentially different combinations of 
Outpost settings stored under different profile names.  Profiles are user-defined 
based on your specific needs.  Once defined, you can switch from one profile to 
another.  Your current settings are saved prior to the profile change. 

An Example 

The typical use of Profiles may be for the user who uses packet for casual use as 
well as in support of a local drill and emergency.  For instance, here is an example 
of 2 profiles that were created by this user.  

Jim KN6PE uses Outpost for both casual and emergency use.  When he is 
cruising the packetsphere, he uses his Outpost Profile.  Using his own call sign, 
he goes to his favorite BBS and likes to check for personal messages, 
information on RACES, and updates on satellite keplerian elements. 

When he participates in any city or county drills, he switches to his Emergency 
Profile.  He has set up his City’s call sign and tactical call, the local emergency 
BBS, and other settings that align with the packet procedures and policies of the 
county’s RACES team. 

 

Profile Name Outpost Emergency 

Station ID 
Setup > Identification 

KN6PE K6KP 

Tactical Call 
Setup > Identification 

 Use Tactical Call  Use Tactical Call 
     Tac Call=CUPEOC 

Additional ID Text 
Setup > Identification 

<blank> Cupertino EOC 

BBS Friendly Name 
Setup > BBS 

K6FB-2 W1XSC-1 

Automation 
Tools > Send/Receive Settings 

 Schedule a S/R session 
     every [ 10 ] minutes 

 No Automation 

Retrieving 
Tools > Send/Receive Settings 

 Retrieve Private messages
 Retrieve Selected Bulletins 
     Filter = RACES, KEPS

 Retrieve Private messages
 Retrieve Selected Bulletins 
     Filter = XSCEVENT 

Message Numbering 
Tools > Message Settings 

 Add Msg numbering
 Add Local Msg number 

 Add Msg numbering 
 Add Local Msg number 

Tracking 
Tools > Message Settings 

 Auto-delivery Receipts  Auto-delivery Receipts

Adv 
Tools > Message Settings 

 Auto-Start Opdirect…  Auto-Start Opdirect…

Miscellaneous 
Tools > General Settings 

 Show Station ID on startup
 PC Time Check 

 Show Station ID on startup
 PC Time Check 
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6.2 Setting up a new Profiles 

1. On installing Outpost for the first time, the “Outpost” profile is loaded as shown 
on the top of the Outpost main form. 
 

 

2. Any configuration changes made are stored in the Outpost Profile. 

3. To create a new Profile, select Setup > Profiles > New Profile…  
 

 
 

4. When prompted, enter the Profile name… and then press OK. 
 

 
 

5. Outpost uses the settings from the current profile to start off the new profile, and 
loads the new profile. 

6. All updates made to Outpost from this point onward will become part of this 
new profile, until another profile is created or selected. 

6.3 Changing Profiles 

7. Profiles are selected from the drop-down box on the main Outpost form.  When 
Outpost runs, the last profile used will be loaded as the current profile. 
 

 

6.4 Deleting Profiles 

8. To delete a Profile, select Setup > Profiles > Delete Profile…. 
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9. Select the profile to be deleted from the drop-down list.  Press OK to delete the 
profile.  The next Profile in the list will be loaded as the current profile. 

 

10. In the event you delete all profiles, Outpost will re-create the Outpost profile 
with the program’s initial installation default settings. 

6.5 Profile Considerations 

1. There no limit to the number of profiles that you can define.  However, the more 
you create, the more variations in Outpost configurations you need to keep 
track of. 

2. If you tend to use more than one call sign for different needs, I recommend 
leaving Tools > General Settings, “Show Station ID on startup” checked so you can 
see if a call sign or tactical call change was made. 

3. There is no way to directly rename a profile.  However, if you do want a profile under a 
different name, create a new profile with the new name and delete the old one. 

4. And, as is the case when changing BBSs, when picking a new profile for a 
different BBS, you still need to change the frequency of your radio to align with 
the profile. 
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7 Other First-Time Setups 
 

There are 2 other areas that are worth setting up prior to beginning with Outpost. 

7.1 Report Settings 

There are a series of settings that help manage Outpost’s report and message 
identification features.  This form is accessible from Tools > Report Settings… 

The Variables tab holds values that are used during the message creation process.   

 

Figure 27: Report Settings Menu 

The fields in this form are defined as follows: 

Fields Description 
Next Message 
Number 

This is a sequential message number that can be added to a 
Message’s subject line, incorporated into an NTS message, 
or accessed by an On-line report.  Each time it is accessed, 
it is incremented to the next number. 

NOTE: If Next Message Number is set to zero (“0”), it is 
not incremented to the next number when accessed. 

Default: 100  

Organization A free-form text field that can contain the name of the 
organization that you may be supporting or to which you 
belong.  Sample organization names are:  

Cupertino ARES/RACES 

Department of Health Services 
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Fields Description 
City A free-form text field that contains the name of a City.  

Typically, this is the City name from which you are 
operating.  

County A free-form text field that contains the name of the County 
or district.  Typically, this is the County name from which 
you are operating.   

State/Prov A 2 character text field that contains the name of the State 
or Province.  Typically, this is the State or Province name 
from which you are operating. 

Tactical 
Location 

A free-form text field that contains the name of the 
Tactical Location.  Sample tactical location names are:  

Seven Springs Fire Station 

Santa Clara Valley Medical Center 

Tactical ID A 3 character text field that is usually an abbreviation of 
the tactical location.  Sample tactical IDs (and what they 
could refer to) are:  

SSF (Seven Springs Fire Station) 

VMC (Santa Clara Valley Medical Center) 

Tactical IDs are used in On-line reports and with the 
Automatic Message Identifiers option.  When turned on, 
the Automatic Message Identifiers feature creates a 
concatenated field of the “Tactical ID” and the “Next 
Message Number” that is inserted on a message’s Subject 
Line.   

For instance, if the next message number is 247 and the 
Tactical ID is “VMC”, the string “VMC247: ” would be 
inserted on the subject line. 

Tactical TX 
Text 

This is the string that is used with the Tactical Call feature.  
It is appended to the Legal Identifier that is sent at the end 
of any Outpost session whenever Tactical Calls are used. 

Text Variable 
#2, #3 

Two free-form text fields that can contain any string.  
These are primarily used with On-Line reports. 

 

Report variables are accessed by various Outpost features.  Note that all settings can 
be used with On-Line Reports. 

Field On-Line 
Reports 

NTS 
Message 

Maker 

Message 
Subject 

Line 

Tactical 
Calls 

Next Message Number     
Organization     
City     
County     
State/Prov     
Tactical Location     
Tactical ID     
Tactical TX Text     
Text Variable #2, #3     
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To fill in the report variables, do the following: 

1. From the Outpost main menu, select Tools > Report Settings. 

2. Fill in the fields.  When done, press OK.  

Typically, defining report values only has to be done once for all reports.  Once 
these fields are filled in, the report values will be referenced by any of the above-
mentioned functions during run-time.   

See Section 15 Online Reports, for information on how references to these values 
can be embedded into your custom reports. 

 

Second Tab:  The Reports tab sets up for one-touch (Hot Key) loading of On-
Line Report Templates. 

 

Figure 28: Report Hot-Key Menu 

On-line report names can be entered in one of two ways: 

1. Direct Entry.  You can type in the report name and path into each field.  
When you press OK, a check is made to verify that the file exists. 

2. File Selection.  To find and select a file, click on the […] button at the end 
of the entry field.  A form pops up that allows you to browse and select a 
file name out of the \reports directory.  Press OK to load the File 
Location Menu, then OK when done. 
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After these on-line reports are defined and set up, they show up on the Outpost main 
form under the Actions menu as follows: 

 

 

Third Tab:  The ICS 309 tab sets up information for running the ICS 309 
Communications Log program. 

 

Figure 29: ICS 309 Communications Log menu 

The following controls are available on this form: 

Controls Description 
Automation No Automation.  When this option is checked, no 

automatic running of the report occurs.   

Schedule Every….  Interval Scheduling: when this option 
is checked, Outpost will automatically run the report every 
“X” number of minutes in full automated mode with the 
previously setup.  The timing for this is determined by the 
operator, with valid settings ranging from 1 to 999 minutes 
(about 16 hours and 40 minutes). 
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Controls Description 
Default:  No automation 

Other ICS309 
fields 

These fields can be set up here and passed to the ICS309 
program at run-time.   

Task ID: defines the designator for this event 

Task Name: defines the event name 

Radio Operator Name: set from the Station Identification 
form. 

Station ID: Call sign, set from the Station Identification 
form. 

If left blank here, you can still fill them in on the Ics309 
form directly. 

7.2 Script Settings 

You can define Outpost Scripts to run as part of the Outpost process.  This form is 
accessible from Tools > Script Settings… There is only one form for these 
settings: 

 

Figure 30: Script Setting Menu 

The options on this form are defined as follows: 

Operation Description 
Start/Stop 
Scripts 

Run this script on Startup.  When checked, Outpost 
will run the named script immediately after starting up. 

Run this script on Exit.  When checked, Outpost will 
run the named script as one of the last steps in shutting 
down. 

In both cases, the Browse Button ensures you can find 
and declare the exact name of the script. 
Wait for script to complete before exiting Outpost.  
If “Run this script on Exit” is checked, then this 
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Operation Description 
option is enabled.   

If UNCHECKED, Outpost will start the script and 
immediately exit.   

If CHECKED, Outpost will wait for the script to 
exit before exiting.  This is useful if your exit script 
needs to run a final Send/Receive Session. 

 

Define 
Send/Receive 
Process 

This option lets you decide how the Send/Receive 
process will run. 

Send/Receive runs standard process.  When 
checked, this option runs the standard Send/Receive 
process exactly as it is defined within the application.   

Send/Receive runs a custom script.  When checked, 
this option runs a user-defined script that controls the 
Send/Receive process.  This applies to both manual and 
automatic Send/Receive initiation. 

 

OK For any option where a script is defined, Outpost will 
validate that the script actually exists before closing the 
form. 

 

Considerations when running Scripts from Outpost 

The above options begin to give the user a lot more control over how Outpost runs.  
With this control is the risk for unanticipated problems, and requires the user to 
consider the following: 

1. Scripts that are developed to be run from Outpost should END and EXIT 
when done.  The Opscripts EXIT command will cause Opscripts to 
terminate once the script completes.  This is important to avoid having 
multiple instances of the Opscripts running at the same time, thereby 
avoiding a house-keeping issue. 

2. Unless you really want this to happen, these scripts should not be set up to 
loop unless it is your intent to manually terminate them when they are no 
longer needed.  This is fine for semi-automatic operations where you are 
watching what happens, but should be avoided if you intend to run totally 
automatically. 

3. When automatically scheduling a script as part of the send/receive process, 
make sure the Send/Receive automation time interval is sufficient to ensure 
you do not try to kick off another script before the last run complete.  This 
will result in contention of the main Packet Session Manager and cause all 
kinds of problems. 



Outpost Packet Message Manager v2.7 
Users Guide 

January 15, 2013 65

7.3 PC Time Check 

There are times when the PC you are using is not up to date with the current time.  
While this is not a problem for casual packet users, it does become a big problem 
during activations where message time-stamping is critical in the event a historical 
picture needs to be recreated. 

The goal is to catch the PC Date/Time problem before any messages begin to flow. 

Outpost provides a PC Time Check tool to prompt the user to confirm the time for 
PCs that have a tendency to forget the time or that are not on the internet with 
access to NIST or Windows Time servers. 

PC Time Check can be run in two means: 

1. Manual run.  Setup > PC Time Check 

2. Run at startup.  Tools > General Settings, check the box for “PC Time Check”.  
When set, the PC Time Check program will run when Outpost starts.  

 

The program simply presents the date and time of your PC.  If it is current, Press 
Close.  If it is not current, press Update.  The Update fields are enabled allowing 
you to make changes to both the Date and Time.  Press Apply when done, Cancel.  
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8 Working with Messages 
8.1 Introduction 

Sooner or later, you will want to create and send a message.  This is where 
Outpost’s Message forms come in.  There are two ways to get to these forms: 

1. From Outpost’s Main window, you can create a new message by either 
pressing the New button, or the Actions > New Message menu.  Or,  

 
2. You can view an existing message by highlighting the message with the 

mouse, then either press the Open button, select the Actions > Open a 
Message menu, double-click on the message, or by highlighting a message 
and pressing the “Enter” key.   

 

NOTE: With the In Tray selected, new unread messages are listed in BOLD.  Urgent 
Messages are listed in RED!! 

 

Figure 31: Message Windows for editing and viewing 



Outpost Packet Message Manager v2.7 
Users Guide 

January 15, 2013 68

The message form helps get a message put together quickly and formatted the way 
you want it to look.  Several fields are filled in automatically, and the Tools > 
Message Settings form provides plenty of controls and options that further 
enhance the message setup process. 

8.2 The Edit Message Window 

This form lets the user create and edit a message prior to it being sent.   Note that in 
the figure below, all fields are enabled and are available for editing. 

 

Figure 32: Message Window Layout 

NOTE:  Some of the more common menu items are also implemented as Tool Bar buttons.  
See the associated menu item below for their description. 

 

Menu Description 
File Send:  Outpost checks that all fields are filled in, saves 

the message to the Out Tray, and then closes the 
Message Form.   

This function is also a button on the toolbar. 

Note: If the message is greater than 10,000 characters, 
a warning is issued.  If the user presses OK, then the 
message is truncated to 10,000 characters. 

___________________________________________ 

Open a File.  Prompts the user to select a text file 
from the system file area.  Once selected, the file’s 
contents are loaded into the message area. 

Open a Report.  Prompts the user to select an On-
Line Report from the system file area.  Once selected, 
three things happen:  
(i) the file’s contents are loaded into the message area, 
(ii) any embedded <tags> are replaced, and  
(iii) the cursor positions to the first data input point. 
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Menu Description 
See Section 15 Online Reports for more details. 

Save.  Checks that at least the Subject field is filled in, 
saves this message to the DRAFT Folder, and then 
closes the Message.   

NOTE: If message is saved as a Draft message, 
Outpost will set the main listing Type field to the word 
"DRAFT".  Once cleared, the Type field reverts to "  ", 
"B", or "NTS" to indicate the message type. 

If the message is greater than 10,000 characters, a 
warning is issued.  If the user presses OK, the message 
is truncated to 10,000 characters. 

This is also a button on the toolbar. 

Save As.  Allows the user to save the message to an 
ASCII text file on the system disk.  Address 
information is also saved, but not in a format that can 
be reloaded back into the message heading fields. 

Save As, No Headers:  Saves the body of the 
highlighted message to an ASCII text file without the 
message headers (From, To, Date, Subject). 

___________________________________________ 

NTS Message Maker.  Brings up a form that guides 
the user through the steps for creating and addressing 
an NTS-compatible packet message. 

___________________________________________ 

Process a Report.  Causes Outpost to start searching 
a loaded On-line report for input prompts.  This option 
is enabled only after an Open a Report menu option 
(above) is performed. 

Clear Remaining Prompts.  Causes Outpost to 
remove all remaining On-Line Report prompts.  This 
option is enabled only after an Open a Report menu 
option (above) is performed. 

___________________________________________ 

Print.  Allows the user to select a printer, and then 
print the currently highlighted message to the printer. 

Print, No Headers.  Same as Print above, but no 
message header (BBS, From, To, Subject, Date) is 
printed.  

Print Setup.  Allows the user to select a default 
printer for Outpost.  

___________________________________________ 

Close.  Closes the form without saving or sending any 
message started. 
 

Edit Cut:  Copies and deletes any highlighted text from any 
field.  The text is placed in the MS-Windows clipboard. 

Copy:  Copies any highlighted text in any field.  The 
text is placed in the MS-Windows clipboard. 

Paste:  Inserts text from the clipboard at the position 
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Menu Description 
where the cursor is located. 

 

 

___________________________________________ 

Clear Message: Erases the contents of this message. 

Select All:  Selects all text in this message.  

Delete Message: Deletes this message without 
saving it. 

Actions Set as a Private Message.  Sets this message as a 
Private Message.  It will be sent with the SP command.  
This function is also a button on the toolbar. 

Set as a NTS Message.  Sets this message as a NTS 
Message.  It will be sent with the ST command.  This 
function is also a button on the toolbar. 

Set as a Bulletin Message.  Sets this message as a 
Bulletin Message.  It will be sent with the SB 
command. This function is also a button on the toolbar. 

___________________________________________ 

Request Delivery Receipt.  Requests that the 
receiving Outpost station automatically send back a 
message indicating that the message was downloaded 
and received.  

Request Read Receipt.  Requests that the receiving 
Outpost station automatically send back a message 
indicating that the message was opened.   

___________________________________________ 

Reset Font (default).  Resets the font size back to 
the form’s default size (Courier, size=10). 

 

Window Reset form to Normal:  Occasionally, the form will 
get stuck in either a minimized state or a maximized 
state, and cannot be restored to a movable window.  
This button resets the form to the default setting. 
 

Help No On-line help enabled.  Points the user to this User 
Guide. 
 

URG Tool Bar only – Sets this message as an Urgent 
Message. 
See the examples of how an Urgent Received message 
is displayed. 
 

  Previous / Next message.  With this form open, this 
control closes this message and opens either the 
Previous () or Next () Message in the current list.  

A A Two buttons, decreases (smaller A) or increases (larger 
A) the font size on the message forms.   
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8.3 The Viewing Message Window 

This form is for viewing received messages (found in the In Tray) or sent message 
(located in the Sent Folder).  None of the address or message fields are can be 
changed. 

Figure 33: Message Viewing Window Layout 

NOTE:  Some of the more common menu items are also implemented as Tool Bar buttons.  
See the associated menu item below for their description. 

 

Menu Description 
File Save As.  Allows the user to save the message to an 

ASCII text file on the system disk.  Address 
information is also saved, but not in a format that can 
be reloaded back into the message heading fields. 

Save As, No Headers:  Saves the body of the 
highlighted message to an ASCII text file without the 
message headers (From, To, Date, Subject).    See the 
General Settings menu for information on enabling 
this feature. 

_________________________________________ 

Print.  Allows the user to select a printer, and then 
print the currently highlighted message to the printer. 

Print, No Headers.  Same as Print above, but no 
message header (BBS, From, To, Subject, Date) is 
printed.  

Print Setup.  Allows the user to select a default 
printer for Outpost.  

_________________________________________ 

Close.  Closes the form without saving or sending any 
message started. 
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Menu Description 
Edit 

 

Copy: Copies any highlighted text in any field.  The 
text is placed in the MS-Windows clipboard. 

_________________________________________ 

Select All:  Selects all text in this message.  

_________________________________________ 

Delete Message: Deletes this message without 
saving. 

View Packet Header.  Shows the details on the received 
packet header that is not copied into the body of the 
message. 

Actions 

 
 

Reply:  For an existing message, opens a new message 
window, initializes the address fields, and formats the 
original message as a Reply Message.  

NOTE: BBS field is set to the BBS from where this 
message came. 

Reply to All:  Similar to Reply, this option is enabled 
when a message is received from a Winlink RMS, 
CMS node, or JNOS BBS and has multiple addressees 
in the To: field. 

Forward:  Forwards the message by opening a new 
message window, initializes the address fields, and 
formats the original message as a Forwarded Message. 

NOTE: BBS field is set to the currently defined 
BBS, not necessarily the BBS from where this 
message came. 

Resend:  This option allows you to resend a 
previously sent message, either with the same message 
ID or with the next assigned ID.  All fields are 
available for editing when Resend is selected. 

 
 

NOTE: For PacFORM messages, the New Message ID 
option is disabled to ensure message entigrity. 

_________________________________________ 

Add Address:  This option is enabled when an 
address book packet message is received.  Outpost lets 
you send Address Book entries to other users.  When 
an Address Book entry is received, the user can add 
this address to the local Outpost Address Book. 

Change Route: This option is enabled when an ICS 
213 message is received.  This menu lets the user 
change the message routing to a different named 
Ics213mm.exe user.  See the ICS 213 Message Users 
Guide for details. 
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Menu Description 
Windows Reset form to Normal:  Occasionally, the form will 

get stuck in either a minimized state or a maximized 
state, and cannot be restored to a movable window.  
This button resets the form to the default setting. 
 
 

Help No On-line help enabled.  Points the user to this User 
Guide. 
 

Archive Closes and moves the message to the Archive folder. 
 

Expire or Accept Tool Bar only – The label on this button changes 
depending on the type of message being viewed: 

1. For received PRIVATE messages, this button is 
hidden. 

2. For received BULLETINS that you send, this 
button displays Expire.  By pressing this button, 
you are prompted to confirm that you want Outpost 
to delete your Bulletin off of the BBS during the 
next Send/Receive Session. 

3. For NTS messages that someone else sent, this 
button says Accept.  By pressing this button, you 
are agreeing to service the NTS message that is 
open, and want Outpost to delete the NTS message 
off of the BBS during the next Send/Receive 
Session. 

 
  Previous / Next message.  With this form open, this 

control closes this message and opens either the 
Previous () or Next () Message in the current list. 

A A Two buttons, decreases (smaller A) or increases (larger 
A) the font size on the message forms.   

8.4 Address information 
Field Description 
BBS When opening a new message, this field is set to the 

currently selected BBS.  However, it could be changed 
to a different BBS if desired. 

For received messages, this field contains the name of 
the originating BBS. 

From For new messages, this field is set to the currently 
configured Station Call Sign or Tactical Call (if 
enabled). 

NOTE: This field cannot be changed once the message 
form is open.  To change, close the message, go to 
Setup > Identification, and name the operator change 
there. 

When viewing a received message, this field contains 
the Station Call Sign or Tactical Call of the sending 
station. 
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Field Description 
To Outpost supports three types of addresses:  

 FCC Call Sign or Tactical call of the station to 
which this message is to be delivered. 

 Hierarchical addressing is supported for 
forwarding beyond the BBS.  This is in the form 
(i.e.): KN6PE@N0ARY.#NCA.CA.USA.NOAM. 

 Winlink RMS/CMS messages, the To: Field can 
hold multiple addresses separated by semicolons.   
 
A Winlink address can be any legal call sign or an 
internet email address.  Email addresses must have 
the “SMTP:” prefix so that the destination address 
looks something like this:  SMTP:kn6pe@arrl.net.
 
Bulletins and Tactical Calls cannot be used with 
the Winlink system. 

For new messages, destination addresses can be entered 
directly or as part of an Address Book entry (alias or 
distribution list).  Additionally, one or more entries can 
be entered at a time thereby sending the message to one 
or more recipients.  This happens differently depending 
on the BBS that is being used. 

For received messages, this field contains the address 
of the destination station.  For Winlink, all destination 
addresses are listed. 

NOTE:  See Section 10 Using the Address Book for 
details on setting up Distribution Lists 

Subject For new messages, enter a subject for this message. 

When viewing an existing message, this field contains 
the subject of the message. 

Sent Date This is the date/time listed with the message on the 
BBS and acts as the message’s Post Date/Time 

Received Date This is the date/time when the message was actually 
received by Outpost.  This field only is displayed on 
Received messages. 

8.5 Message Area 

The Message Area is a free-form text area that supports cut and paste, tabs  
(Cntl-Tab), word-wrap, text importing, and other simple formatting functions.  
Rich Text formatting is not supported. 

Because of packet’s ultimate transmission speed, packet messages should be long 
enough to convey the intended meaning while being short enough to conserve 
bandwidth and minimize channel congestion. 

NOTE:  Most HF BBSs have a 3,000-character limit on packet messages.  If you must send 
large messages, it is recommended that you break them up into smaller messages to 
reduce channel contention. 

NOTE:  Outpost enforces a hard 10,000-character limit for sent and received messages.  If 
the out-going message is greater than 10,000 characters, a warning is issued and the 
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message is truncated.  For incoming messages, Outpost will truncate the message up 
to 10,000 characters, and then write the entire message to the Session Log file. 

8.6 Creating a message 

The Steps for creating a message are: 

1. From the main Outpost Window, click on the New button.  A new message 
form will open.  The BBS: and From: fields will be pre-loaded with the current 
system information.  These can be changed if necessary. 

2. Enter the To: (Destination) call sign or tactical call sign.  For Winlink, multiple 
addresses can be entered when separated by a semicolon.  Or, you can enter an 
Address Book entry by pressing the To: button.  See Section 10 Using the 
Address Book for details. 

3. Enter the Subject:.  Up to 128 characters of subject can be entered.  However, 
this does not imply that the receiving BBS can actually support that number of 
characters. 

4. Enter the Message.  Outpost will wrap around any text that reaches the right 
side of the form.  If you are sending it to another Outpost station, line-wrap is 
handled correctly and all formatting is preserved.  Message length is limited to 
10,000 characters. 

NOTE: For non-Outpost users, the message may not look as “neat” at the receiving 
end due to limitations of the receiving program and its ability (or inability) to 
handle line wraparounds. 

5. Verify the message type.  From the Actions Menu, set the message type 
(Private, NTS, or Bulletin) if you want something different from the default 
Private message type.  The message type is displayed in the highlighted area 
below the Tool Bar buttons.  

Figure 34: Selecting the Message Type 

6. The Message Type can also be set using the three buttons on the message form:  

▪ Pvt:  Private 

▪ Bul: Bulletin 

▪ NTS: NTS message 

7. When you are done with your message and satisfied with the way it looks and 
reads, press the Send button.  The message is placed in the Out Tray and will 
be transmitted during the next Send/Receive Session. 

8. If you are not done, you can press the Save button.  The message is saved into 
the Draft folder.  You can retrieve, edit, and Send it later. 
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8.7 Creating an Urgent Message 

Outpost allows you to set a message so that it is indicated as an URGENT message 
at the receiving end.  To do this, proceed as follows: 

Figure 35: Setting Message to Urgent 

1. On the Message form, press the Urg button (A).  The message header (B) 
shows it is to be sent as an Urgent Message.  Pressing the Urg button again 
changes the message back to non-urgent. 

2. Once the message is retrieved by the receiving station, it is listed in the In Tray 
with all the other messages, and indicated as Urgent by:  
(i) 2 red “!!” in the “U” (Urgent) column, and  
(ii) highlighted message listing in RED  (C). 

Figure 36: Receiving an Urgent Message 

3. The message will continue to remain listed in red until it is deleted from 
Outpost, forwarded, or replied to.  The message will also change from BOLD 
text to unbolded text to indicate that it has been opened and read. 

8.8 Requesting Message Receipts 

Outpost allows you to request a Delivery Receipt and a Read Receipt from the 
receiving Outpost station. 

 A Delivery Receipt is a request for notification that the message you sent was 
actually downloaded by Outpost on the receiving station.  It does not mean that 
it was stored on the BBS. 
 
Once the receiving station retrieves their packet messages, during the same 
Send/Receive Session when the message was downloaded, Outpost 
automatically formats and sends back a short Delivery Receipt message to the 

A

B
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requesting station.  No user interaction is required. 
 

 A Read Receipt is a request for notification that the Sent Message was actually 
opened.  It does not guarantee that the message was actually read or 
understood.   
 
When a received message containing a Read Receipt is opened, Outpost 
automatically formats a short Read Receipt message.  This message will be sent 
back to the requester during the next Send/Receive Session. 

Both Delivery and Read receipts can be requested at the same time if desired. 

To request a delivery or read receipt, from the message form, press  
Actions > Request Delivery Receipt or Request Read Receipt. 

Figure 37: Setting up a message with Receipt Requests 

After the message is delivered to the receiving station, the requesting station sees 
the following: 

 An entry in the message listing indicating a Delivery Receipt (B) 

 A short Delivery Receipt message containing date and time details of the 
receipt. 

A similar message listing and message is returned for Read Receipts. 

Figure 38: A Delivery Receipt Message 

A

BBB
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8.9 Forwarding or Replying to a message 

Messages that you receive from another packet station can be forwarded to a 
different user, or replied back to the originator.  Outpost helps with the formatting 
so that the original message can be referenced. 

1. Forward.  After you select a message for viewing from the Outpost main 
window, you can press Forward.  This action does the following: 

 A new copy of the message is created and reformatted with an “original 
message” header.  The original message is preserved. 

 The From: field is set to the current Station Call Sign. 

 The To: Field is cleared and should be set to the station to receive this 
message. 

 The user can now add or edit the text message as appropriate. 

 Press Send when done. 

Figure 39: Forwarding a message 
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2. Reply.  This command operates exactly the same as the Forward with the 
following exception: 

• The From: and To: fields of the original message are swapped so that 
the message will be sent back to the originator. 

8.10 Forward and Reply Considerations 

1. The Forwarding and Replying feature does add text to the message that  
(i) may not always be needed, and (ii) consumes channel bandwidth.  This 
should be of particular concern if the packet channel is heavily used. 

If you need to reply to a message, consider editing the original message of 
unnecessary text to reduce the message bulk, provided you do not alter the 
meaning you want to communicate.  Your organizational policies on 
handling Forwards and Replies should be considered. 

2. When replying or forwarding a message, the message type is set according 
to the Message Settings found at Tools > Message Settings.  
Regardless of the setting, you can override this setting from Actions Menu 
by setting the message type as described above (Private, NTS, or Bulletin). 

8.11 Sending a text file 

The text of the message can also originate from a text file created elsewhere.  To 
import a message from a text file, do the following: 

1. From the main Outpost Window, click on the New button.  Fill on the To: 
and Subject: fields. 

2. Select File > Open.  Navigate to the directory where the file resides and 
select the file.  Press OK.   

3. The text will be loaded into the Message area and the message title is set to 
the text file name. 

Figure 40: Sending a text file 
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9 Customizing Message Settings 
 

9.1 Introduction 

While Outpost works fine “out of the box,” it does provide several options for 
controlling how the program behaves, particularly around Message Settings.   

There are several options that you can set to control how messages are handled.  
These settings are accessed from the main Outpost menu  
Tools > Message Settings…  

The form is made up of a series of Tabs across the top.  These tabs are: 

Tabs Description 
New Messages Describes how new messages are set up.  See the field 

descriptions below. 
 

Msg Numbering Set up message numbering options. 
 

Replies/Forwards Chooses how replies and forwards are handled.   

 

Tracking Allows the user to set global Delivery and Read 
Receipt requests. 

 

Deleting Controls for what happens when you delete a message. 

 

Advanced The controls on this tab are used for interacting with 
external programs that can create messages in Outpost. 

 

 

The following sections describe these tabs in detail. 
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9.2 Settings for New Messages 

First Tab:  This menu controls how messages are created. 

 

Figure 41: New Messages Tab 

This set of options control how Outpost handles new messages.   

Control Group Description 
Message Type 
Default:   

Set Default to Private: When set, a new message 
defaults as a Private message.  Usually, most messages 
are sent as Private Messages to ensure that only the 
recipient sees the message.   

Set Default to Bulletin:  When set, a new message 
defaults as a Bulletin. 

NOTE:  If an NTS message is created, the default is 
 overridden and the message is set as an NTS  
 message. 

Default: Set as Private 

 

Create and Send 
NTS messages as 
Private messages 

Several users prefer the NTS message format for 
passing messages with the intent for their messages to 
stay “local”. In these cases, the standard NTS address 
that Outpost generates is not required. 

This option overrides the NTS addressing controls and 
allows the message to be created and sent as a Private 
Message. 

When checking this option, on sending a message, the 
SP (Send Private) command is used instead of the ST 
(Send Traffic) command.  The user needs to fill in the 
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Control Group Description 
destination. 

Default: UNCHECKED 

 

Default Destination For stations operating in the field or at a local 
municipality, it may be typical for them to address the 
bulk of their message traffic to the same Operational 
Area EOC or some other station.  

To reduce the risk of addressing errors, the user can 
enter a default destination address.  To use this feature, 
check the Default Destination box, and then enter the 
destination address in field provided.   

The next time a new message is created, the To: field 
on the message form is automatically filled in with this 
address.  If necessary, this field can be subsequently 
changed for “one-off” messages going elsewhere. 

Default: Not Set 

 

Signature Inserts the specified signature text into the body of all 
new messages. 

This is a free-form text field and can be as large or 
small as necessary.  However, keep in mind that 
excessive signatures add channel traffic.  Careful 
consideration should be taken when defining a 
signature. 

A separate signature file is set up for each user. 
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9.3 Settings for Message Numbering 

This menu controls how message numbering is applied to a message. 

 

Figure 42: Message Numbering Tab 

Outbound Message Identifier 

It is good operating practice (if not a requirement of your organization) that all 
messages be uniquely identified so that they can be subsequently referenced.  This 
option automatically places a unique message identifier in the subject line for each 
message created.   

To automatically add a message number/identifier to the subject line, do the 
following: 

1. On this form, press the Edit Subject Line Identifier values button, or 
Select  Tools  > Report Settings...  
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2. Verify the “Next Message Number” field is set to the first number with 
which you want to start your message numbering. 

3. Verify the “Tactical ID” field is set to any special 3-character string 
identifier you may be using.  This field is Optional. 

4. Press OK when done.   

5. Select  Tools  > Message Settings...   

6. Click on “Add Message Number to Subject Line”. 

7. Press OK when done.   

For instance, suppose this option is checked and the Report Settings form is filled 
in as follows: 

In Santa Clara County, CA, “CUP” is the 3-character county designation for the 
City of Cupertino.  The next time a new message is created, Outpost automatically 
places a message identifier in the subject line in the following format: 

<tactical id><next message number>: 

So, assuming the above report settings, the following is the result the next time a 
message is created: 

 

At this point, the user can enter additional subject line text following the identifier.  
In Santa Clara County, the combination of the Tactical ID and the Message Number 
uniquely identifies this message for the County EOC. 

The next message created after the above message would have the Message 
Identifier of “CUP127: ”, and so on (see the next section for the exception). 

These options control how Outpost assigns message Identification numbers to a 
message.   

Control Group Description 
Outbound Message 
Identification 

When checked, any message that you create will have a 
message identifier assigned. 

Without hyphenation:  the 3 character tactical 
Identifier and number are side by side. 

With hyphenation:  the 3 character tactical Identifier 
and number are separated by a single dash character  
“-”.  This is useful if your 3 character Tactical Identifer 
contains numbers such a “F12” for Fire Station 12. 

Data Format:  the 3 character tactical Identifier 
followed by a 12 digit numeric date/time string in the 
format: yymmddhhmmss.   
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Control Group Description 

NOTE:  If the Tactical ID is left blank on the Report 
Settings form, then only the number is entered 
in the subject line. 

Default:  UNCHECKED 

 

Inbound Message Identifier 

There are some municipalities that require that all messages, both outgoing and 
incoming, be identified with a Local Message ID.  Outpost can now optionally 
assign all incoming messages with a Local Message ID (LMI).  Once this option is 
enabled, this field and its value will show up as follows: 

1. Message Listing:  The LMI field will be visible as part of the base message 
listing for all folders.  If not used, the field can be shrunk so that it is not 
displayed. 

2. Message Display:  If an LMI value is assigned, it will be presented on the 
message form. 

3. Read and Delivery receipts:  The LMI value will be added to all receipts 
sent back to the original sending station. 

4. ICS309 Comm Log:  The LMI value is optionally included in the ICS 309 
Communications Log report. 

 

Control Group Description 
Inbound Local 
Message 
Identification (LMI) 

When checked, all informational messages that you 
receive will have a message identifier assigned.  
Administrative messages (READ:, DELIVERED) 
messages will not have an LMI assigned. 

Assign a Local Message Number…:  When checked, 
the LMI will be assigned. 

Default:  UNCHECKED 

 

NOTES 

1. The LMI value will have a “P” listed after it to indicate it as a Packet Message.  
This should help the EOC staff differentiate it from other types of messages 
that are coming in.   

2. In the event there is a need to change or remove the “P”, this is done by editing 
the Outpost.ini file directly in this section: 
[MESSAGE PREFERENCES] 
    : 
LMIsuffix=P 
    : 

After editing this value, save the file, and restart Outpost. 
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9.4 Settings for Replies and Forwards 

The 3rd tab controls how a message behaves when it is selected for Replying or 
Forwarding.   

 

Figure 43: Replies/Forwards Tab 

 

The following table summarizes the options available. 

Controls  Description 
Replies/Forwards 
defaults 

Set default to Private Message:  When this option 
is checked and when replying to or forwarding a 
message, regardless of the original message type, the 
message will be set as a Private message. 

Set default to Received Message Type:  If this 
item is checked and when replying to or forwarding a 
message, the message type will be set to be the same as 
the original message type. 

NOTE:  This option excludes NTS messages. 

Default: Set to Private  

 

Close original 
message…  

To avoid desktop clutter, checking this box will close 
the original message after selecting it for replying or 
forwarding.  If you want to leave the original message 
open while completing a reply or forward message, 
uncheck this box. 

Default: CHECKED: close message on reply or 
forward. 
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9.5 Tracking Messages 

The 4th tab controls how Outpost handles global message receipt requests. 

 

Figure 44: Tracking Tab 

The following summarizes the options available. 

Controls  Description 
Always request a 
Delivery Receipt. 

This option is set by the originating station. 

When this setting is checked, all messages will be sent 
with a Delivery Receipt request set.  This option can be 
overridden for individual messages at the time the 
message is being created. 

Always request a 
Read Receipt.   

This option is set by the originating station. 

When this setting is checked, all messages will be sent 
with a Read Receipt request set.  This option can be 
overridden for individual messages at the time the 
message is being created. 

Auto-Delivery 
Receipt 

This option is set by the receiving station. 

Sometimes it is useful for the receiving station to send 
an acknowledgement that the message was delivered.   

This option sends a Delivery Receipt for Private and 
NTS messages back to the originating station, 
REGARDLESS of whether a Delivery Receipt was 
requested by the originating station.  Bulletins are 
skipped. 

Auto-Read Receipt This option is set by the receiving station. 

Sometimes it is useful for the receiving station to send 
an acknowledgement that the message was read. 

This option sends a Read Receipt for Private and NTS 
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Controls  Description 
messages back to the originating station, 
REGARDLESS of whether a Read Receipt was 
requested by the originating station.  Bulletins are 
skipped. 

9.6 Settings for Deleting Messages 

The 5th tab controls how outpost handles deleting messages.   

 

Figure 45: Deleting Tab 

The following summarizes the options available. 

Controls  Description 
Deleting 
Messages 

In general, deleting a message from any folder (other 
than the Deleted Mgs folder) will cause the selected 
message to be moved to Deleted Mgs folder. 

However, deleting a message from the Deleted Mgs 
Folder permanently deletes the message from Outpost.  
This option determines whether the user is prompted to 
confirm that they really want to permanently delete the 
message. 

Default: CHECKED; prompt before final delete 

9.7 Advanced Settings 

PacFORMS is a system of browser-based (HTML) forms that provide a user-
friendly way to enter specific information ultimately to be transmitted by Packet 
radio.  Field labels and blank fields are not sent.  Similarly, Ics213 Messaging is a 
different message capture form that also sits outside of, and interacts with Outpost.  
Both rely on the Opdirect Message Capture System, a program for receiving 
messages from these 2 sources. 
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See: http://www.scc-ares-races.org/pfpublic/pacforms.html for details. 

The 5th tab controls how Outpost handles these external message sources.   

 

Figure 46: Advanced Tab 

Controls Description 
Automatically 
enable Opdirect 

The Opdirect.exe program is delivered with Outpost 
and listens for and processes incoming message from 
PacFORMS and Ics213mm.exe.  If you intend to use 
either of these 2 reporting programs, you MUST turn 
on Opdirect.exe. 

Once checked, you will have to restart Outpost. 

If the Opdirect.exe program is missing from the 
Outpost directory, this option is not enabled. 

Default: UNCHECKED 

When opening a 
locally created 
PacFORMS… 

This option is used with the PacFORMS solution.  If 
the 2nd or 3rd option is selected and Outpost detects a 
locally submitted PacFORM message when opened in 
the Outpost Message form, Outpost will automatically 
pass the message to the pac-read.exe program for 
displaying in its native HTML form. 

Default: Never open in its native program 

When opening a 
received 
PacFORMS… 

This option is the same as the above, but applies to 
PacFORMS messages received from a remote station. 

Default: Never open in its native program 
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10 Using the Address Book 
10.1 Introduction 

The Address Book is integrated with Outpost and provides the following features: 

Multiple address formats 

The AX.25 packet world has evolved into a mix of different address types that 
Outpost can support.  These are: 

Call Sign KN6PE
The most common addressing scheme used.  This 
works with all BBS/PBBSs out there. 

Tactical Calls CUPEOC
Tactical Calls are supported by Outpost and make an 
assignment operator-neutral. 

Hierarchical Address KN6PE @K6KP
KN6PE @K6KP.CA.USA.NOAM 
KN6PE @K6KP.#NCA,CA.USA.NOAM 
The different variations of these address types depends 
on the destinations and the capabilities of BBS in use 
(such as using White Pages). 

NTS 95014 @NTSCA
This is a variation of the Hierarchical addressing 
scheme, and is treated differently on a BBS. 

SMTP kn6pe @arrl.net
SMTP:kn6pe@ arrl.net 
The xNOS and Winlink BBS families support standard 
smtp address with only a minor difference with 
declaring the address in the TO: field. 

 

Address Book entries 

Single User entries.  When you create an address book entry for a single address, 
you essentially are creating an Alias.  You can define a friendly name (such as 
JIMOB) and associate it with a single address for those hard-to-remember call signs 
or email addresses (such as KN6PE or kn6pe @arrl.net). 

Distribution List entries.  Multiple addresses can be entered under a single 
friendly name to create a Distribution List (DL). 

Other information can be associated with the entry as well, such as phone numbers, 
agency names, and general free-form text fields. 

When creating a message with an Address Book entry, the single or DL names are 
entered into the TO: field as usual, with the “+” sign in front of alias name (+JIMOB 
or +SCC-RACES).  The “+” sign tells Outpost that this is an address book entry, and 
not a directly entered address. 

Forwarding Address Book Entries 

You can share your address book entries by forwarding them to other Outpost users.  
These packet messages will be the bare minimum made up of the entered data that 
can be loaded into the recipient’s address book at his/her discretion. 
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Mixed-use To: lines 

Initially, any Winlink user who populated a bunch of addresses onto the TO: field 
was managing the distribution list in their head.  Now, Outpost users can enter 
addresses, single user address book entries, DLs, or in any combination. 

Address Book substitution at message send time 

Once an Outpost message is being processed for sending, Outpost checks the To: 
line for any address book entry, and expands it into its defined address(es).  

Winlink naturally handles lists of addresses, so Outpost will do nothing more than 
expand any address book entries into their defined addresses, and then sent the 
message as is.  Winlink will manage distributing the message as it does today. 

For JNOS, if Outpost detects multiple addresses on the To: line, when performing a 
Send, it changes the SP (Send Private) command with the SC (Send Copies) 
command, and formats the message so that a single message is send to multiple 
addressees.  Like Winlink, JNOS then manages distributing the message as it does 
today. 

Other than Winlink and JNOS, there is no other known BBS that supports handling 
a list of addresses within one message.  When Outpost encounters a DL for a non-
WL2K/JNOS BBS, it will expand the distribution list and create one packet 
message for each distribution list entry.  So, a DL with 5 entries will result in 5 
messages being sent, one to each recipient. 

Duplicate address checking at message send time 

With the advent of DLs and the ability to add multiple destinations on a message, 
the risk of creating duplicate messages goes up.  While not really an issue on the 
internet side, this is a problem for RF-sent messages since many environments are 
still operating at 1200 baud and duplicate messages needlessly consume bandwidth.  
Regardless of the BBS, all To: lines will be checked for duplicate entries.  If 
duplicates are found, then they are removed. 

Address type checking at message send time 

One of the Outpost features is its ability to “discover” the type of BBS being used at 
the time you initiate a Send/Receive Session.  Because not all BBSs support all 
address formats, Outpost will check the To: line and each address format against the 
BBS to ensure that no inappropriate address formats are sent.  Address type 
checking is performed against this table:  

BBS/PBBS Types 
Address Types 

Call Sign Hierarchical/NTS SMTP 
All Kantronics 
All MFJ 
All AEA/Time Wave 

 
 

 
 

 

AA4RE    
BPQMailChat    
DXNET    
F6FBB    
HAMSERV    
JNOS, TNOS, SNOS    
MSYS    
N0ARY    
NNA    
OpenBCM    
RLI    
WL2K (RMS, CMS)    
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10.2 Address Entry 

This section describes how an address book entry is set up.  

The form for making and reviewing Address Book entries is accessed from the main 
Outpost menu Setup > Address Book…  

The form is made up of 2 Tabs across the top.  These tabs are: 

Tabs Description 
Address Entry This tab contains that critical definition items for an 

address entry. 
 

Contact 
information 

Additional (and optional) information can also be 
entered to further define an entry. 

 

 

The following sections describe these tabs in detail.  The 1st Tab is the Address 
Entry Tab. 

 

Figure 47: Address Entry Tab 

This tab has the following fields: 

Fields Description 
Find a Name A Pull-down menu of the address entries previously 

entered in Outpost.   

After pressing the New button, this field is hidden and 
not used. 

Default: the first address entry listed. 
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Fields Description 
Details  Name:  When Finding a Name, this field shows the 

name of the address picked by the above pull-down 
menu. 

When creating a new entry, this is the field for entering 
the friendly name for the new address book entry. 

 

Org:  Optional, This field lets you enter an 
organization name for this address entry. 

Default: Blank 

 

Options Single User Address.  Click this option if you are 
defining a single user address.  When this option is 
checked, the address field will not let you enter in 
spaces, commas, or semi-colons typically used to 
separate more than one address entry. 

Distribution List.  Click this option if you are defining 
a distribution list.  When this option is checked, you 
can enter one or more addresses in the address field 
separated by spaces, commas, or semi-colons. 

Default: Single User Address 

 

Packet / email 
Addresses 

Enter one more addresses in this field.  See the rules for 
separating addresses for distribution lists in the options 
description above. 

 

Notes Optional; Enter any free-form comments or notes for 
this particular address. 

 

 

The following describes the controls that are available. 

Controls Description 
New Sets up a new address book entry.  All fields on the 

menu are either cleared or set to their default settings. 
 

Copy Lets the user to copy or Clone the currently displayed 
address entry.  When pressed, the friendly name is used 
along with the words “--COPY_OF” appended to it to 
ensure it is a unique name.  This name can then be 
changed, along with the other fields for this entry. 
 

Forward Lets the user forward the currently displayed address 
entry as a packet message.  This is a good way to 
ensure that users within your operating group are using 
the correct addresses for common messaging when 
Bulletins do not make sense. 
 

New Message Action Menu only, creates a new message addressed to 
the entry being displayed. 
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Controls Description 
Delete Lets the user delete the currently displayed address 

entry.  The user will prompted whether they really want 
to delete the entry. 

OK Same as Apply, but closes the menu on completion if 
the field validation is successful. 
 

Apply Causes all required fields to be validated.  On 
completion, the address entry menu remains open.  The 
Apply button becomes enabled as soon as any field is 
changed by an update to an existing configuration or by 
creating a new address book entry. 
 

Cancel Cancels any changes that may have been made to the 
form, and the form is closed. 
 

 

The 2nd Tab holds optional contact information on this address entry. 

 

Figure 48: Contact Information Tab 

The following summarizes the fields available. 

Fields Description 
Phone Numbers Home.  Optional, fields for entering a home phone 

number. 
 
Cell.  Optional, fields for entering a cell phone number. 
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Fields Description 
Business.  Optional, fields for entering a business 
number. 
 
Agency #1, #2.  Optional, Name and phone numbers 
for any agency associated with this entry. 
Default: Blank 

 
More Notes Optional, Enter any free-form comments or notes for 

this particular address.  This could be directions, 
special instructions for these individuals, etc. 

Default: Blank 

 

10.3 Thoughts on address naming standards 

Think about how you will use your address book entries.  Because Outpost will 
confirm that address type (Call sign, hierarchical, smtp) against the BBS type, it will 
aggressively try to avoid an address error at send/receive time.  HOWEVER, this 
may give you a false sense of security that any message you create will ALWAYS 
get delivered to the end user regardless of the BBS.  THIS IS NOT THE CASE (see 
Section 10.1 on Address Type Checking for this discussion). 

One suggestion is to create addresses for different BBS Types.  For instance: 

DL_CARES_AEC A DL used for a local KPC3 PBBS 
DL_CARES_WL2K A DL used for a local RMS node with smtp addresses 
JIMO_HOME  A single address entry of my home email 
JIMO_JNOS  A single address entry to my home JNOS node 

Defining such an addressing scheme is purely optional.  But if you intend to share 
distribution lists, you may want to agree to some address naming standard to keep 
the confusion and training factor to a minimum. 

10.4 Setting up a new Address Book Entry 

Unlike setting up TNCs or BBSs, creating address book entries is strictly optional 
and would be used more as a productivity enhancer rather than a requirement.  
While you can still enter addresses directly into Outpost’s message form, creating 
address book entries helps cut down on typing errors by defining the address once, 
and then using it over and over again. 

Set up a new Address Entry as follows: 

1. Select Outpost’s Setup > Address Book…, then press the New button. 

2. Enter a Friendly Name.  This is the name that you can use to identify the 
entry. 

 For Single entries, it could be the individuals’ name, initials, or some 
other description. 

 For Distribution Lists, it could be an organization or group name.  
Whatever you use, I recommend you keep it short and memorable. 

3. Check the Address Type option.  Select either Single Address Entry or 
Distribution List. 

4. Enter the Address.  Depending on the selected address type, enter one or 
more addresses as appropriate.  Regardless of the Address Type option you 
choose, you must enter at least one address. 
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5. Fill in other optional fields.  

6. Press Apply.  This will validate that all required fields are filled in correctly, 
and leave the form option.  Or, press OK to validate and close this form. 

10.5 Updating an existing Address Entry 

Once you have address entries, you can review or update them whenever you want.  
Update an entry as follows: 

1. Select Outpost’s Setup > Address Book…, then use the pull-down menu to 
review the list of addresses. 

 

2. Click on the name you wish to review or update.  That entry will be loaded. 

3. Make whatever changes you want to this entry, then press OK.  

10.6 Using Address Book entries in messages 

Once you have your address entries defined, you can use them in messages.  For 
Outpost to know you are using an Address Book entry, place a “+” plus sign in front 
of the entry.  To use an Address Entry as follows: 

1. From Outpost’s main menu, press New to open a new message. 

2. In the To: Field, enter the address entry.  If you are entering multiple 
entries, separate them with spaces, commas, or semi-colons. 

3. As soon as you tab out of the field, Outpost will clean-up all entries (case 
and separators). 

 

HINT:  Double-clicking on an Address Book Entry will immediately open the Address 
Book to that entry.  This is a good way to confirm you want this message going 
to this list of people, or want to make changes to the list on the fly. 

HINT:  Avoid dashes “-“ in names if you want to double-click on an entry… Windows 
does not pick up the entire DL entry as a single word; the underline “_” 
character works fine. 
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10.7 Auto-picking an Address Book entry 

With the message form open, note that the message’s To: field is a selectable 
button.  

 

To select existing address book entries, 

1. Press the To: (A) will open the address book quick pick form. 

2. Scroll through the list of addresses and double-click on each entry to be 
added (B). 

3. As the address entries are added, they are formatted and listed to the right of 
the form  (C).  Any number of entries can be added. 

4. Press OK when done and the selected message recipients will be appended 
to the To: field. 

A

B

C

A

B

C
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10.8 Forwarding Address Book entries 

While having a DL or other Address Book entry is good for your personal 
productivity, having the same lists used by members of your communications team 
improves the productivity and efficiency of the entire team.  This could be a DL of 
your immediate response team, a DL of SMTP addresses you use for Winlink 
forwarding, or just a general update on yourself in terms of your contact 
information. 

Regardless with how you use the Address Book, Outpost lets you share entries with 
your team by forwarding it as a packet message. 

You can share an Address Entry as follows: 

1. Select Outpost’s Setup > Address Book… 

2. Use the pull-down menu to find the address you want to forward.  Once you 
have it, press the Forward button. 

3. Outpost will create a new message with a compact list of the address book 
entry fields. 

4. Note the layout of this message: 

 !ADDR!  begins the address book entries 
 [.]  ends the address book entries 

 

5. Complete the message as usual: 

 Fill in the destination To: field 
 Make any changes to the Subject Line 

 Set the Message type as Private or Bulletin 

 Add any additional message text that you want. 

 Press Send. 

NOTE:  You can add text Before the !ADDR! tag or after the [.] tag.  DO NOT place any 
additional text in between these tags! 
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10.9 Receiving Address Book entries 

On the receiving end, an Address Book message will be retrieved like any other 
message.  However, it is up to the recipient to determine whether they want to add it 
to their local Address Book or not. 

1. Retrieve your messages as you usually do, and then open the message. 

2. Press the Actions > Add Address menu option to add this address to your 
address book.  This option is enabled only when an Address Book entry is 
received. 

 

3. If an entry by the same name exists, you will be prompted if you want to 
overwrite it. 
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11 Customizing the Send/Receive Session 
 

Outpost provides several options for controlling how the Send/Receive Session 
executes.  The control options are accessed from the Outpost main menu,  
Tools > Send/Receive Settings… .These settings are discussed here. 

11.1 Automating the Packet Session 

Messages can be sent to the BBS whenever the Send/Receive button is pressed on 
the main Outpost form. 

However, if Outpost is used as part of an ARES/RACES network for moving packet 
traffic within an Operational Area, then having the means for automatically sending 
outgoing traffic and polling the BBS for incoming traffic on a periodic basis allows 
Outpost to operate unattended, thereby making more efficient use of the emergency 
responder staff. 

The 1st Tab, Automation, controls how Send/Receive Sessions will be executed. 

 

Figure 49: Send/Receive Automation Menu 

Operation Description 
No automation When this option is checked, no automatic initiation of 

Send/Receive Sessions occurs.  This means that, to 
initiate a session, the user needs to: 
▪ Press the Send/Receive button on the Outpost 

main form, or  
▪ Have Outpost send the message immediately after 

a message is created (discussed below). 
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Operation Description 
Schedule… every 
“X” minutes 

Interval Scheduling: when this option is checked, 
Outpost will initiate a Send/Receive Session every “X” 
number of minutes.  The timing for this is determined 
by the operator, with valid settings ranging from 1 to 
999 minutes (about 16 hours and 40 minutes). 
 
To use this feature:  
▪ Check the “Schedule a send/receive every [   ] 

minutes.” box. 
▪ Enter the number of minutes between sessions. 
▪ Press OK. 
▪ The time remaining until the next Send/Receive 

Session will be displayed on the status bar, bottom 
right, just to the left of the System Time. 

▪ To disable this setting, check the  
“No Automation” button, then press OK.   

 
See the Automaton Considerations section below for 
more information about how to use Send/Receive 
Automation. 
 

Schedule…  at 
“X” minutes past 
the hour 

Slot Time Scheduling:  You may want to explicitly 
control when a Packet Session is to run.  This is 
handled by using a concept known as “slot times.”  
Valid slot times are in the range of 0 to 59, and 
correspond to the minutes pass the current hour. 
 
To use this feature:  
▪ Check the “Schedule a send/receive at “X” 

minutes past the hour.” box. 
▪ Enter any number of absolute times in minutes 

when you want Outpost to run.  The times are the 
minutes during an hour when a session will run.  
For instance, entries of 2, 17, 32, and 47 mean 2 
minutes past the hour, 17 minutes past, etc. 

▪ Press OK. 
▪ Based on the current PC system time, Outpost will 

determine the next time to run a Packet Session, 
and the time remaining until that session will be 
displayed on the status bar, bottom right, just to the 
left of the System Time. 

▪ To disable this setting, check the  
“No Automation” button, then press OK.   

 
See the Automaton Considerations section below for 
more information about how to use Send/Receive 
Automation. 
 

Send a Message 
immediately 
when it is 
complete. 

This setting causes Outpost to initiate a Send/Receive 
Session immediately on completing a message and it is 
validated by pressing the Send button on the message 
form.  A full Send/Receive Session will run. 
 
This option does not have any impact on any other 
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Operation Description 
existing Automation timing that may already be 
selected.  The session timer will continue to count 
down to the time of the next Packet Session regardless 
if it is 15 minutes from now or 30 seconds from now. 
 

 

Automation Considerations 

In general, automatic message retrieval allows Outpost to be physically located in 
the radio room and periodically check for incoming or out-going messages.  This 
meets the requirement for having a control operator present. 

The rules around applying automatic message retrieval timing must be worked out 
within your Operational Area.  For instance, in a configuration with a low 
traffic/low station count, setting an interval time of 10 to 15 minutes may work with 
little or no collisions.  However, this may not be the case with a high traffic volume 
or a large number of stations needing access to a single BBS. 

For instance, consider an environment of 5 Hospitals needing access to a single 
BBS on a single frequency.  If the objective is to avoid any transmission collisions 
and maximize the times to check for messages, then the 5 Hospitals could be 
coordinated and assigned time slots with 3 minute intervals.  For instance: 

Slot 1 Slot 2 Slot 3 Slot 4
Hospital 1 0 15 30 45
Hospital 2 3 18 33 48
Hospital 3 6 21 36 51
Hospital 4 9 24 39 54
Hospital 5 12 27 42 57

Slot times

 

 

Similarly, 8 hospitals could be assigned time slots with 2 minute intervals: 

Slot 1 Slot 2 Slot 3 Slot 4
Hospital 1 0 15 30 45
Hospital 2 2 17 32 47
Hospital 3 4 19 34 49
Hospital 4 6 21 36 51
Hospital 5 8 23 38 53
Hospital 6 10 25 40 55
Hospital 7 12 27 42 57
Hospital 8 14 29 44 59

Slot times

 

 

In the above case, Hospitals 8 and 1 are within 1 minute of each of their slots and 
some contention may result. 

 Most BBS’s are very robust and can handle multiple connections at the same 
time.  There is no requirement to avoid concurrent access to a channel by 
multiple Outpost users.  Channel contention is still handed by the TNC.   

 When configuring the Outpost environment with time slots, all Outpost 
deployment teams should take into account available transmission speeds (1200 
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vs. 9600 baud), expectations for packet traffic volume, number of packet 
stations on a channel, and the willingness of served agencies to accept delays 
due to time-outs when channel contention occurs.  Some experimenting may be 
required. 

 Not all slot times need to be filled in.  At least 1 time slot must be configured 
for this feature to be used. 

 There could be situations where some packet stations may generate more 
packet traffic then others and need access at least 4 times an hour.  Other 
stations may need fewer slots.  Again, these assignments should be carefully 
planned and coordinated to fully optimize the channel. 

11.2 Selecting messages for retrieval 

The 2nd tab Retrieving allows you to configure Outpost to selectively retrieve 
messages from the BBS: 

 

Figure 50: Retrieving Menu 

Operation Description 
Retrieve Private 
Messages 

Private messages are addressed to an individual.  Once 
Outpost retrieves and stores a private message, the 
message is deleted off of the BBS (unless configured to 
do otherwise). 

 

Retrieve NTS 
Messages 

NTS messages are identified by an address that 
includes a zip code and state (95014@NTSCA).  Once 
Outpost retrieves and stores an NTS message, the user 
has the option to accept the message for servicing and 
direct Outpost to delete it off of the BBS.  See the 
section on the Message Form for details. 

Not accepting the message for servicing leaves the NTS 
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Operation Description 
message on the BBS for someone else to pick up. 

 

Retrieve 
Bulletins  

Bulletin messages are addressed to anyone who can 
access the BBS. 

Outpost will not attempt to delete retrieved bulletin 
messages off of the BBS. 

If you originated the message and retrieved it, when 
you view the message, the Expire button is enabled.  
By pressing Expire, the Bulletin will be deleted the 
next time you perform a Send/Receive Session. 

When Retrieve Bulletins is selected, the Retrieve 
Messages based on Filters option is unchecked. 

Retrieve Selected 
Bulletins or 
xNOS Areas 

This option does the same thing for standard BBS and 
xNOS systems, however the manner it does it is 
different for each. 

Non-xNOS Systems 
The selected messages are one or more messages that 
satisfy the entered filter or mask.  Sometimes referred 
to categories, the LC command on some BBSs return 
the list of categories that are present.  At least 1 filter 
must be entered.  

NOS Systems (JNOS, TNOS, SNOS, etc) 
The NOS systems organize these messages in Areas.  
The filters or masks entered in the form essentially 
guide Outpost to these Areas where the L command is 
then performed. 

Regardless of the BBS, Outpost will perform a message 
list and retrieval for each filter mask or NOS area that 
is identified.  Any number of masks or areas can be 
entered. 

When Retrieve Messages based on Filters is selected, 
Retrieve Bulletins option is disabled. 

See Filtered Retrieval Considerations below for more 
details on this feature. 

Skip NTS 
Messages I sent 
to the BBS 

NTS messages that you originate will normally be 
retrieved. 

If this option is checked, the NTS messages you 
originated will not be retrieved, thereby reducing 
channel contention by not downloading a message that 
is now currently in your Sent Folder.   

Skip Bulletins I 
sent to the BBS 

Bulletins that you originate will normally be retrieved.   

If this option is checked, the bulletins you send will not 
be retrieved, thereby reducing channel contention by 
not downloading a bulletin that is now currently in your 
Sent Folder. 

However, you will not be able to delete this bulletin 
without retrieving it and pressing the Expire button on 
the bulletin’s message form. 
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Filtered Retrieval Considerations 

When Emergency Response Organizations rely on a networked BBS for their 
message traffic where operational and non-operational traffic may be present, or 
when a BBS is used to post a variety of bulletin data, retrieving ALL bulletins is 
neither an effective option nor an efficient use of the frequency. 

Most BBSs offer one or more commands that allow the user to retrieve messages 
based on the destination (To:) Call Sign or the message’s category (category @ 
route).  Outpost supports the capability to selectively retrieve messages during a 
Packet Session based on the message list-matching capabilities of the BBS. 

A cursory check of a few BBSs shows that there are different commands for filtered 
message listing.  Some of these commands are: 

L> string List the messages where “string” matches the call sign of the 
destination address; could match the category field in a 
destination address (category @ route). 

BBS: AA4RE, F6FBB, some TNC PBBSs. 

L string List the messages where “string” matches the category field 
in the destination address (category @ route). 

BBS: MSYS 

A string 
L 

A (Area) command followed by “string” moves the user 
from the logged on area (i.e.: KN6PE) to the new area.  The 
L command then lists the messages in the area. 

BBS: JNOS, TNOS, SNOS, other NOS derivatives 

 

NOTE:  Check your BBS for the exact command options for selective retrievals. 

The Filtered Retrieval Option is intended for selective retrieval of BULLETIN 
messages.  This means: 

1. The “Retrieve Private Message” option should still be used to retrieve 
private messages addressed to you since Outpost will attempt to delete private 
messages just retrieved off of the BBS. 

2. Selectively retrieved messages are bulletins; no attempt will be made to delete 
them off of the BBS. 

3. BBS retrieval rules apply: if a selectively retrieved message was previously 
downloaded and is still on Outpost, no attempt is made to download it again. 

Other Considerations 

 If a Bulletin is sent to a specific individual (such as KN6PE) instead of a 
general category (such as ALLCTY, etc.), that message will be picked up as a 
Private message regardless of the BBS message setting and is subject to the 
Private Message handling rules described above.  However, the receiving 
Outpost station will not be able to delete it because it was not the author of the 
Bulletin.  Only the originators of Bulletins can delete the bulletin. 

 NTS messages will be deleted from the BBS only after the user accepts the 
message for servicing.  If you have no intention of servicing an NTS message, 
DO NOT ACCEPT THE MESSAGE.  If you accidentally accept an NTS 
message, please post it back to the BBS so someone else can service it. 
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11.3 Once a message is received 

The 3rd tab Receiving handles the settings once a message is downloaded by the 
receiving station. 

 

Figure 51: Receiving Menu 

 
Operation Description 
Play this sound 
on arrival 

This option allows you to select a .wav file to be played 
when a message is saved in Outpost. 

The user can browse for a .wav file, select it, and test it 
to confirm that it is suitable for their environment. 

See the Play on Arrival Considerations below. 

 

Keep on BBS, do 
not delete after 
retrieving 

There are cases where it may be desirable to leave 
Private or NTS messages on a BBS after they are 
downloaded.   

For instance, a municipality or response team may be 
operating 2 Outpost stations in different locations under 
the same Operational Call sign (if the BBS supports it) 
and wants both stations to see messages specifically 
intended for them. 
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Play on Arrival Considerations 

This feature requires that an operational Sound Card is installed in the Outpost PC.  
Once you choose a .wav file, pressing the “Test” button will cause the .wav file to 
play.  If there is a problem with the file or the sound card, a sound card is not 
installed or enabled, then Outpost will issue a “beep” instead. 

Several .wav files are included with the Outpost distribution as examples for how 
this feature could be used.  For instance, 

 Sound38.wav – a very obnoxious alarm.  If you use this file with the sound 
turned up, you will definitely know when a message arrives. 

 Sound136.wav – used for Notifications. 

 incoming.wav – a spoken notification.  The phrase “Attention, incoming packet 
message” is spoken. 

Essentially, you can use any .wav file found on your system, or create your own.  
The “incoming.wav” file was created using the Microsoft “Sound Recorder” 
program that comes standard with Windows. 

11.4 Printing 

The 4th tab Printing specifies what and how messages will be printed 
automatically.   

 

Figure 52: Other Menu 

Groups Description 
Print received 
messages 

Checking this box will cause Outpost to print each new 
message received on their arrival.  This is useful to 
expedite routing incoming messages to the EOC or 
Operational Area staff.  The number of copies can be 
specified.  See the Print Messages Considerations 



Outpost Packet Message Manager v2.7 
Users Guide 

January 15, 2013 109

Groups Description 
below. 

Default:  unchecked, 1 copy 

Print sent 
messages 

Checking this box will cause Outpost to print each 
message that was successfully sent.  The number of 
copies can be specified.  See the Print Messages 
Considerations below. 

Default:  unchecked, 1 copy 

 

Auto-print with 
message 
headers 

If the above print options are checked, checking this 
box will cause Outpost to print the messages with the 
message headers. 

Unchecking this box will cause only the message text 
to be printed.  This may be desirable if you are sending 
or receiving report-formatted messages and do not want 
the clutter of the packet message header. 

Default:  Checked 

 

Print DELIVERY 
and READ 
Receipts 

If this box is checked and you have automatic printing 
turned on, READ and DELIVERY Receipts will be 
printed as well. 

Default:  UNCHECKED 

 

 

Print Message Considerations 

This feature requires a printer to be configured.  If no printer is installed, this feature 
is disabled. 
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11.5 Notifications 

The 5th tab Alerts specifies what situations will cause a pop-up alert to occur. 

 

 

Groups Description 
Display 
Notifications 

Causes a notification window to be displayed in the 
event there is a problem during the Send/Receive 
Session.  The window stays up even after the 
Send/Receive Session window closes. 

See Notifications Considerations below. 

Default:  N0, N1, N2, N3 checked 

 

Play this sound 
on notification 

This option allows you to select a .wav file to be played 
when a notification window pops up. 

The user can browse for a .wav file, select it, and test it 
to confirm that it is suitable for their environment. 

Default:  checked 

 

 

Notification Considerations 

During an unattended Send/Receive session, something may cause an unexpected 
BBS disconnect or error condition that may go unnoticed. Outpost will now 
generate a pop-up notification message for the following conditions: 

 BBS type could not be identified. 
 Unexpected BBS disconnect while sending messages 
 Unexpected BBS disconnect while retrieving the list of messages. 
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 Unexpected BBS disconnect while retrieving a BBS message. 
 Unexpected BBS disconnect while attempting to delete a BBS message. 
 BBS <name> does not support multiple destinations addressing 
 Addressing problems such as Address type does not match BBS type. 

 

The notification will be displayed in a pop-up message window that remains on the 
screen even after the Send/Receive Session ends.  On receiving a notification, an 
alert signal (beep if no sound card is available) will also be sounded.  Notifications 
can be turned off if necessary. 

NOTE: Other conditions may be added as situations of concerns are identified. 

11.6 Other settings 

The 6th tab Other are other general settings you may wish to set. 

 

The 6th tab has the following option. 

Groups Description 
Show Packet 
Session Window 

When the Send/Receive Session runs, a window pops 
up and displays the transactions between Outpost and 
the TNC.  To hide this window, uncheck this option. 

Default:  checked 
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12 Packet Session Manager 
12.1 Introduction 

The Packet Session Manager is the Outpost message processor that manages the 
entire interaction with the BBS through the selected interface (TNC, AGWPE, or 
Telnet).  It initiates all commands needed to configure the interface and connect to 
the BBS, detects all TNC and BBS prompts, and controls the sequence of events to 
send and receive messages. 

After pressing Send/Receive from the Outpost main window, or if Send/Receive 
Automation is enabled, the following window opens and reports on the progress of 
the session. 

 

Figure 53: Serial Port Packet Session Manager Screen 

12.2 Toolbars 

Because the Packet Session Manager is an automated process, there is only one 
control on this form.   

Control Description 
Abort Session Attempts to terminate the Packets Session. 

Depending on where you are during the Packet Session, 
the control will perform differently.   

Prior to completing a BBS connection, the session is 
terminated. 

After a BBS connection is established, Outpost 
attempts to force a disconnect from the BBS. 

 
Always show this 
window… 

Unchecking this box immediately minimizes this 
window, and causes it to be minimized for subsequent 
Packet Sessions.   

However, the Packet Session window will be available 
on the Windows Task Bar. 
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12.3 Status Line 

On the bottom of the form, status messages are displayed describing where you are 
during the session. 

Item Description 
Status Displays the current activity that the Packet Session 

Manager is performing. 
 

Session Timer Displays the time the Session has been in progress in 
minutes and seconds.  This timer is reset to zero at the 
beginning of each session. 

 

12.4 How the Packet Session Manager works 

The Packet Session Manager process relies on the correct configuration of the 
Interface and BBS.  During the configuration of these two items, various TNC (for 
Serial Port interfacing) or BBS prompts are set up, added, or changed by the user.  
The accuracy of setting these commands and prompts is critical to the correct 
operation on the Packet Session Manager. 

The following describes the general flow of the Packet Session Manager.  Other 
than the interface initialization, the process is essentially the same.   

 

Step Description 
1. Start-up The Packet Session Manager is scheduled either 

manually from the Outpost Main form by pressing the 
Send/Receive button, or automatically.   
 
Prior to doing anything, a check is made to ensure: 
(i) Outpost has an Call Sign set as the Station ID,  
(ii) an interface is selected, and  
(iii) a BBS is selected.   
 
If any of these are missing, an error message is shown.  
This error will also disable any automatic Send/Receive 
settings that were previously defined. 
 
Automatic scheduling can be set up by selecting the 
time interval between Packet Session runs.  Once a 
Send/Receive Session ends, it will wait for the time 
period to expire before running again.  This is enabled 
from the Tools > Send/Receive Settings menu. 
 

2. Interface 
Initialization 

Depending on the interface type selected, the interface 
initialization sequence is different.  However, the end 
result is to get to the point where Outpost can log on to 
the BBS. 
 
See the following 3 sections for specifics on the 
different interface initiation sequence. 
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Step Description 
3. BBS Log-on and 
Auto-Prompt 
Detect 

For an RF-based connect (TNC Serial or AGWPE) and 
before issuing the connect command, Outpost checks to 
see what Path was defined to this BBS.  
 
1. For a Direct Path, the connect command is 

formatted and sent. 
2. For a Digipeat Path, the connect command with 

the via station names is formatted and sent. 
3. For a KA-Node/NETROM Path, Outpost 

performs a series of connect requests to each 
defined Node, looks for a successful connect 
prompt, and then issues the next connect request 
command.  Finally, once at the last node, it 
performs the BBS connect request. 

 
Outpost then looks for a “>” character from the BBS.  
This is the minimal prompt that all BBSs use.  Outpost 
looks back over the line of text immediately preceding 
the “>” and builds up the BBS prompt from that string 
(up to 8 characters). 
 
Outpost also looks for the SID to determine the BBS 
type.  The SID tells Outpost how to parse the message 
list and process all retrieved messages. 
 

4. Process Bulletin 
or NTS Deletes 

For bulletin messages, you can issue an Expire Bulletin 
command for a bulletin you previously posted.  
Additionally, for NTS messages, you can Accept an 
NTS message by deleting it off of the BBS. 
 
This step of the Send/Receive Session issues the deletes 
for messages on the BBS for either of the above 2 
cases.  
 

5. Send Messages Outpost checks for valid messages in the Out Tray that 
are addressed to this BBS. 
 
A valid message is any message that has been checked 
by pressing the Send button in the Message form.   
 
NOTE:  Pressing Send ensures all fields are validated 
and complete.  Opening a previously validated message 
in the Out Tray, then pressing Save will not perform 
the validation, and the message will not be sent. 
 
For each type of message (Private, Bulletin, NTS), 
Outpost uses the appropriate BBS Send command to 
format the message for sending, adds all receipt 
requests, sets the Urgent flag if directed, and then sends 
the message. 
 
After the message is sent and a valid BBS prompt is 
received, Outpost does the following: 
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Step Description 
1. checks the “Print on Sending” option to determine 

if a sent message should be printed,  
2. moves the just-sent message from the Out Tray to 

the Sent Msgs Folder,  
3. changes the message status to “Sent,” and  
4. sets the message time to the time it was sent.   
 
Outpost repeats this process until all valid messages are 
sent. 
 

6. Retrieve 
Messages 

Outpost retrieves messages based on the Retrieve 
Message option settings:   
 
1. Checks which messages should be retrieved.  Any 

combination of Private, NTS, Bulletin, and 
Selected messages can be selected.  Also, if no 
message type is selected, no messages are 
retrieved. 

2. Checks the “Keep Messages on BBS” option to 
determine if the downloaded messages should be 
deleted. 

3. Checks the “Print on Receiving” option to 
determine if new messages should be printed. 

4. Checks the “Play on Arrival” option to determine 
if a .wav file needs to be played. 

 
These settings can be made from the  
Tools > Send/Receive Settings… menu. 
 
Assuming there are messages to be retrieved, the 
retrieval process begins with Outpost sending the 
appropriate BBS List command (LM, LB, LT) to 
generate a listing of private messages, bulletins, or NTS 
messages.  
 
For each message found in the BBS message list, 
Outpost does the following: 
(i) issues a BBS Read <message number> command, 
(ii) receives the message from the BBS,  
(iii) decodes the message’s Date/Time,  
(iv) determines if there are any receipt tags, then  
(v) stores the message in the In Tray. 
 
A note on Selected Retrievals:  An unlimited number 
of filter masks can be defined on the Send/Receive 
Settings form.  If “Retrieve Selected Bulletins…” is 
checked, then for each filter mask defined, Outpost will 
generate the list of BBS messages that satisfy that filter, 
and then retrieve those messages. 
 
A note on Bulletins:  Because only the originator or 
SysOp can delete bulletin messages, an additional 
check is performed before retrieving a bulletin.  If a 
bulletin shows up on the BBS message list, Outpost 
first checks to see if it has previously downloaded that 
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Step Description 
bulletin based on the BBS Msg Number and BBS 
Name combination associated with each message that 
Outpost retrieves.  If a match is found anywhere on 
Outpost (regardless of the folder), then the bulletin is 
not downloaded.  If no match is found, then the bulletin 
is downloaded. 
 
After storing a received message in the In Tray, and 
depending on the message type, Outpost does 1 of 2 
things: 
 For Private messages, Outpost will either keep or 

delete the received message from the BBS based 
on the Tools > Send/Receive Settings. 

 For NTS and Bulletin messages, Outpost will not 
attempt to delete the message at this point.  See 
Step 4 above for details. 

 
A note on undeleted Private messages:  If the user has 
enabled the setting to “Keep messages on the BBS” 
option, than a similar check is performed each time the 
Packet Session is run to ensure duplicate messages are 
not downloaded.  Once this option box is unchecked, 
the message then will be deleted off the BBS next time 
Outpost runs. 
 

7. Send Receipt 
Messages 

Prior to ending a session, any pending Message 
Receipts are sent out.  This second “Send” cycle allows 
for incoming messages with Delivery Receipt requests 
to be immediately processed without waiting for 
another session. 
 

8. BBS Log off Outpost sends the command to exit the BBS. 
  
After the BBS disconnects, if a Digipeat or KA-
Node/NetROM Path was used, Outpost assumes that all 
intermediate stations will disconnect in turn, leaving 
Outpost looking at the local TNC prompt. 
 
The command is considered successful when a TNC 
prompt is detected for a direct serial or AGWPE 
connection, or other termination status is detected for 
Telnet. 
 

9. Interface Shut-
down 

Finally, the interface is shut down based on the 
interface type.  See the following 3 sections for details. 
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12.5 Serial Port Packet Session Specifics 

Outpost’s Serial Port operations follow a standard method for setting up and 
communicating to a device on a Comm Port.   

Step Description 
1. Start-up See the description above.  Once Startup is complete, 

the serial port process picks up from here. 
 

2.1 Initialize the 
Comm Port 

Comm Port initialization is performed at the beginning 
of each Packet Session where a Serial Port Interface is 
selected. 
 
Because Ipserial.exe (Outpost’s Terminal Emulator 
program) may be running and monitoring the channel, 
Outpost looks for ipserial.exe and sends that program a 
Comm Port disconnect command.  This ensures that the 
Send/Receive Session can connect without a Comm 
Port contention error. 
 
The Comm Port is then initialized based on the data 
entered into the Comm Port Settings menu, and then 
the port is opened.  If the port is already in use by 
another program (other than Ipserial.exe), an error 
message is displayed, and the session ends. 
 

2.2 TNC 
initialization 

The TNC is initialized each time the Packet Session is 
run. 
 
The first command Outpost sends to the TNC is a “b.” 
While the command typically causes the TNC to reply 
with its Broadcast status, it also forces a TNC prompt 
to be displayed (if the TNC is working correctly). 
 
Outpost looks to see if the TNC sent back a TNC 
Prompt string as defined during TNC Setup.  On 
detecting the prompt, a “TNC ok” message is displayed 
in the status window at the bottom of the display.   
 
Outpost then sends the following commands to set up 
the TNC: 
 Echo.  Forces the TNC echo status to “On”.  This 

causes the TNC to echo all Outpost commands sent 
to the TNC back to the Packet Session Manager 
window. 

 Mycall call_sign.  Sets the TNC to the call sign 
that is currently the Outpost call sign. 

 Monitor.  Forces TNC channel monitoring to OFF.  
This prevents the TNC buffer from filling up with 
unwanted text in between Packet Sessions. 

 Date/Time.  Sets the TNC to the date and time of 
the host computer. 

Outpost then checks if a TNC Initialization File was 
defined.  If so, it reads each command in the file, and 
sends it to the TNC. 
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Step Description 
Normal Packet 
Session processing 

See steps 3 through 7 above 
 
 

8. Close Comm 
Port  

The process is reversed after disconnecting from the 
BBS. 
 
Outpost checks if a TNC Initialization File was defined 
and post-session commands are defined.  If so, it reads 
each command in the file, and sends it to the TNC. 

 
If Tactical Call is turned on, Outpost builds up a text 
string containing the legal call sign, the tactical call 
sign that was used, and an optional test string as 
defined at the Setup > Identification… menu.  A TNC 
command is issued to put the TNC into an Unproto 
(Converse) Mode, and then broadcasts the station 
identification string. 
 
The Comm Port is closed thereby allowing other 
programs to access the serial port without closing 
Outpost. 
 
To re-instate any Ipserial.exe monitoring that was set 
up, Outpost looks for ipserial.exe and sends a Comm 
Port Connect command.  This causes Ipserial to 
reconnect to the Comm Port and send the Mon On 
command (if configured) to resume monitoring. 
 
The Send/Receive Session window then closes. 
 

12.6 AGWPE Packet Session Specifics 

Outpost’s AGWPE implementation follows the standard interface approach as 
specified by SV2AGW.  The AGWPE sequence of events is as follows: 

Operation Description 
1. Start-up See the description above.  Once Startup is complete, 

the AGWPE process picks up from here. 
 

2.1 Connect to 
TCP/IP Interface 

The first action for an AGWPE interface is to establish 
a TCP/IP connection with the AGWPE program. 
 
Outpost uses the previously identified Host Name (or 
IP Address) and Port number to establish the 
connection with the AGWPE Program.  Outpost 
attempts to establish the connection, and then tests to 
determine if the connection succeeded.   
 
If the connection failed, an error message is displayed, 
and the session ends.  Connection failures will be 
caused by AGWPE not running or the Host name or 
Port information being incorrect. 
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Operation Description 
2.2 AGWPE Log 
on & Registration 

Once a connection is established, Outpost does 2 
things: 
1. If an AGWPE logon was identified as being 

required, Outpost sends the Logon and Password 
command sequence. 

2. Outpost registers itself with the AGWPE program 
under the call sign of the currently defined Station 
ID. 

 
While AGWPE does not return an error on a logon/ 
password failure, it does indicate if the registration 
failed.  Reasons for a failed registration attempt are:  
 
(i) the logon/password is required but were missing,  
(ii) the logon/password was required but was incorrect, 
(iii) Outpost is already registered with AGWPE under 
this station ID. 
 

Normal Packet 
Session processing 

See steps 3 through 7 above 
 
 

8. AGW 
Disconnect 

Outpost sends a BBS disconnect command and looks 
for the disconnect message. 
 
If Tactical Call is turned on, Outpost builds up a text 
string containing the legal call sign, the tactical call 
sign that was used, and an optional test string as 
defined at the Setup > Identification… menu.  An 
AX25 Unproto frame is sent with the station 
identification string. 
 
Finally, Outpost sends a TCP/IP disconnect command, 
and then an AGWPE Unregister request.   
 
Short of an AGWPE failure, this sequence will process 
correctly. 
 

12.7 Telnet Packet Session Specifics 

Outpost’s Telnet implementation follows the standard Telnet protocol.  The 
sequence of events is as follows: 

Operation Description 
1. Start-up See the description above.  Once Startup is complete, 

the Telnet process picks up from here. 
 

2.1 Connect to 
TCP/IP Interface 

The first action is to connect to establish a TCP/IP 
connection to the Server on which the BBS resides. 
 
Like AGWPE, Outpost uses the previously identified 
Host Name (or IP Address) and Port number to 
establish the connection with the BBS Server.  Outpost 
attempts to establish the connection, and then tests to 
determine if the connection succeeded.   
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Operation Description 
 
If the connection failed, an error message is displayed, 
and the session ends.  Connection failures will be 
caused by network problems or the Host name or Port 
information was incorrect. 
 

2.2 BBS Server 
Log on  

Not all BBS servers reply with a logon prompt after a 
successful connect.  The user may need to hit Enter to 
get the prompt. 
 
After connecting to the server, Outpost immediately 
sends the logon.  If the BBS needed a “kick’ to get the 
prompt, sending the logon name is the kick it needs and 
the logon name will look out of sequence to the BBS 
logon prompt.  However, this does work since the sent 
logon name is buffered at the application until needed. 
 
Next, Outpost watches for the Password prompt, and 
sends the password upon the prompt’s receipt.  It then 
looks for the BBS prompt.  Once it sees this, Packet 
Session processing continues as usual. 
 
If there is an error with the logon sequence, Outpost 
thinks it is waiting for the BBS prompt when instead 
the Logon sequence is probably being presented again.  
Here is where the Network timeout value comes in.  
Outpost waits the value of the timeout, and then exits 
with an error message. 
 

Normal Packet 
Session processing 

See steps 3 through 7 above 
 
 

8. Telnet 
Disconnect 

Outpost sends TCP/IP a disconnect command, and 
exits.  
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13 Using Tactical Calls 
 

13.1 Introduction 

Many governments define a tactical call sign as “a call sign that identifies a tactical 
command or tactical communication facility.” 

Amateur Radio operators use Tactical Calls to identify an assignment with which 
message traffic is exchanged.  Because several different operators may be assigned 
to a specific location over time, a Tactical Call makes the assignment "operator 
neutral," thereby allowing the operators to change without having the assignment 
name change. 

Some examples of tactical calls are: 
 Cupertino Fire A fire station in the City of Cupertino 
 Staging 1  A resource staging area  
 County EOC  The county’s Emergency Operations Center 

Amateur Radio voice nets have used tactical call signs for years.  However, the 
flexibility of tactical calls has been elusive in the packet radio world due to a variety 
of limitations and constraints.  Ideally, tactical call support for packet should be 
implemented at the BBS.  All out-of-the-box BBSs do not explicitly support the use 
of Tactical Calls.   

As a result, Outpost implements Tactical Calls that is usable on all types of BBSs. 

13.2 How it works 

Outpost's implementation of tactical calls is based on substituting a tactical call 
designator in place of the standard Call Sign for message creation (From:), TNC 
initialization (my <call>), and BBS activities (List Mine).  Almost all BBSs do not 
inherently support tactical calls.  However, experimentation has shown that a 
tactical call can be structured to satisfy the log-on and call-sign checking of a BBS, 
and can achieve the intent of what Tactical Calls can offer.   

While the Outpost implementation is not totally fool-proof and does have some 
limitations, Outpost does give packet users the look and feel of tactical calls while 
operating within the Federal Communications Commission (FCC) rules. 

13.3 Is it legal? 

Stations that use a tactical call must also identify with their legally assigned call 
sign.  In the United States, the FCC addresses the subject of station identification in 
Part 97.119, and states that each amateur station “… must transmit its assigned call 
sign on its transmitting channel at the end of each communication, and at least every 
10 minutes during a communication, for the purpose of clearly making the source of 
the transmissions from the station known to those receiving the transmission.  No 
station may transmit unidentified communications or signals, or transmit as the 
station call sign, any call sign not authorized to the station.” 

NOTE:  AX.25 is the underlying protocol that makes packet work.  The AX.25 Link-Layer 
Protocol Specification complies with the X.25 specification with the exception of:  

1. an extended address field, and  

2. the addition of an Unnumbered Information (UI) Frame. 
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The extended address field of every frame is encoded with the station of origin and 
destination amateur call signs.  In short, under typical use, every time an AX.25 
packet is transmitted, it essentially identifies the transmitting station and satisfies 
the requirements of Federal Communications Commission (FCC) Part 97.119.  For 
more information, see: AX.25 Amateur Packet-Radio Link-Layer Protocol 
document found at http://www.tapr.org/pub_ax25.html. 

There are three points to reiterate: 

 Under FCC rules, station identification must occur at the end of each 
communication, and at least every 10 minutes during a communication.  

 The FCC rules do not state that the expanded AX.25 address field with 
embedded Call Sign is required for packet station identification.  While the 
AX.25 implementation satisfies the requirement, this is not the only method 
that the requirement could be met.  

 Outpost satisfies the requirement for legal station identification by transmitting 
the user's valid station call sign at the end of each Send/Receive session.  

13.4 Picking tactical calls 

You will have to experiment with your BBS to see to what extent it supports a 
tactical call.  The following information is based on tests with 3 typical BBSs.  Your 
results may vary. 

KPC3 PBBS 

This PBBS is very flexible and can allow almost any type of Tactical Call structure.  
The tactical call must be no more than 6 characters long.   

The following are examples of usable tactical calls: 
CUPFD A fire station in the City of Cupertino 
STAGE1 A resource staging area supporting a fire line 
CUPEOC Emergency Operations Center at the City of Cupertino 

F6FBB BBS 

This BBS performs limited call sign validation when you first connect to the BBS.  
Testing indicates that the call sign needs to include at least one number to be 
confirmed as a valid call sign. 

As an example, in Santa Clara County, the County Hospital system implemented a 
packet network for its 11 regional hospitals using the F6FBB BBS as its packet mail 
drop.  These hospitals were assigned a tactical call with the structure of <#xxxxx >.  
For instance: 

1MVECH Mountain View El Camino Hospital 
1PASMC Palo Alto Stanford Medical Center 
1SJVMC San Jose Valley Medical Center 
1SJGSH San Jose Good Samaritan Hospital 

 

The basic tactical call format that was used above is: 

1 CC HHH 
 \ \  \___3 letter abbreviation for the hospital name 
  \ \_____2 letters for the city in which the hospital is located 
   \______the number "1"; arbitrary, satisfies F6FBB’s need to see a digit 
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As a check of the above, when a user manually sets up his TNC with the command 
my 1MVECH (sets the TNCs call sign), on connecting to the F6FBB BBS, the BBS 
does not complain and asks the 1MVECH user to register.  In short, the “#xxxxx” 
structure satisfies the F6FBB call sign checking logic. 

13.5 Setting up tactical calls 

To set up a tactical call, do the following: 

 

 

Manual Confirmation 

1. Pick a tactical call structure based on your BBS TYPE.  See the description 
above on how to experiment with tactical calls. 

2. Run Ipserial.exe or some other terminal emulator 

3. Set your TNC to the Tactical Call with the mycall command. 

4. Issue the BBS connect command. 

5. Verify the BBS does not generate an error.  If so, you may need to pick a 
different Tactical Call format.  If it prompts you to register, register this logon. 

Outpost Setup 

6. Select Setup > Identification...  

7. Check the Tactical Call box 

8. Enter your Tactical Call Sign 

9. Enter an optional ID text. 

10. Press OK when done.   

11. Send/Receive to confirm to can connect without problems. 
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14 NTS Message Maker 
 

NOTE:  NTS and NTS Packet are significant topics by themselves and a detailed review is 
beyond the scope of this document.  For more information on NTS Packet, see the 
document titled: Introduction to the National Traffic System available on the 
Outpost website. 

14.1 Introduction 

Outpost supports NTS with the NTS Message Maker.  This tool formats an NTS 
message by presenting the user with a form that enforces the addressing and 
formatting rules required to comply with standard NTS-formatted packet messages. 

This section describes the NTS Message Maker form and how it works.  Refer to 
this figure as part of the example explained in subsequent paragraphs. 

Figure 54: NTS Message Maker Form 

14.2 Menus and Toolbars 

The following controls are provided as part of the drop-down menus.  

Menu Description 
File Close:  Closes the NTS Message Maker form without 

saving the message.  Pressing the button will cause any 
message entered to be lost. 

 

Edit Cut:  Copies and deletes any highlighted text in any 
field.  The text is placed in the MS-Windows clipboard. 

Title, Menu,
Tool

NTS
Preamble

Destination Address

Message

Signature
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Menu Description 
Copy: Copies any highlighted text in any field.  The 
text is placed in the MS-Windows clipboard. 

Paste:  Inserts text from the clipboard at the position 
where the cursor is located. 

____________________________________________ 

Clear Message.  Clears only the Address, Message, 
and Signature fields.   

____________________________________________ 

Clear All.  Clears all fields on the form.   

 

 

Additionally, the following toolbar controls are also provided.  

Controls Description 
ARL Msg Brings up a form that allows the user to select a 

Routine or Emergency ARL message.  Once a message 
is selected, the user is prompted for any embedded data 
needed to complete the message. 
 

Check This button does the following: 
 Checks to make sure that all required fields are 

filled in.  If a required field is missing, the field is 
highlighted. 

 Reformats the Message Text to be consistent with 
NTS packet formatting rules.  This includes 
replacing each period (.) with an “X” and 
reformatting the message so there are only 5 words 
per line. 

The Preamble “Check” field is filled in with the 
number of words in the message. 

 
Save Performs a Check of the message (same as above), then 

saves the message to the Message Form.  The message 
form fields are filled in per the standard NTS packet 
message format. 

 

Clear Message Clears the Address, Message, and Signature fields.  

 

Cancel Closes the NTS Message Maker form without saving 
the message.  Pressing this button will cause any 
message entered to be discarded. 

 

Handling Instr 
Browse Button 

Located to the right of the Handling Instr field in the 
Preamble.  
Brings up a form that allows the user to select a 
Handling Instruction.  Once a message is selected, the 
user is prompted for any embedded data needed to 
complete the entry. 
 



Outpost Packet Message Manager v2.7 
Users Guide 

January 15, 2013 129

14.3 NTS Preamble 

The following fields are part of the NTS Preamble.  

Field Description 
Msg No. Required field.  This is a sequential number beginning 

with 1 each month or year to be assigned by the 
originating station. 
 
Outpost stores the last NTS preamble used.  The 
Message Number is automatically incremented with 
each new message. 
 

Precedence Required field.  The Precedence is a single character 
to be entered in this field.  The four categories of 
Precedence are: 

E - EMERGECNY:  Any message having life or death 
urgency to any person or group of persons.  This 
includes official messages to welfare agencies during 
emergencies requesting supplies, materials, or 
instructions vital to relief of stricken populace in 
emergency areas.  Use the abbreviation “E” in the 
packet message. 

P - PRIORITY:  Important messages having a specific 
time limit.  Official messages not covered in the 
Emergency category are covered here.  Use the 
abbreviation “P” in the packet message. 

W - WELFARE:  A message that is either (a) an 
inquiry as to the health and welfare of an individual in 
the disaster area or (b) an advisory or reply from the 
disaster area.  Use the abbreviation “W” in the packet 
message. 

R - ROUTINE:  Most traffic normally will bear this 
designation.  During a disaster, Routine traffic should 
be handled last or not at all when circuits are busy with 
other traffic. Use the abbreviation “R” in the packet 
message. 

 
Handling Instr Optional field.  Handling instructions (HX) serve to 

convey any special instructions to handling and 
delivering operators.  The following definitions apply: 

HXA number  - Collect landline (phone calls) delivery 
is authorized by the addressee within number miles (if 
no number, authorization is unlimited).  Enter only “A 
number” 

HXB number  - Cancel message if not delivered within 
number hours of filing time; service the originating 
station.    Enter only “B number” 

HXC  - Report date and time of delivery (TOD) to 
originating station.  Enter only “C” 

HXD  - Report to originating station the identity of 
station from which received, plus date and time.  
Report identity of station to which relayed, plus date 
and time, or if delivered report date, time, and method 
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Field Description 
of delivery.  Enter only “D” 

HXE  - Delivering station get reply from addressees, 
originate a message back.  Enter only “E” 

HXF number  - Hold delivery until number (date).    
Enter only “F number” 

HXG  - Delivery by mail or landline toll call is not 
required.  If toll or other expenses are involved, cancel 
message and service originating station.  Enter only 
“G” 

HINT:  Use the Handling Instruction Browse Button to 
the RIGHT of the field to see the definitions and 
prompt for all required information. 

Station of Origin Required field.  This is the first amateur station to 
handle the message.  Typically, this would be you and 
your call sign if you are transmitting the message. 
 

ARL Message Optional Field.  This is a check-box indicating this is 
an ARL message.  These messages include an ARL 
message number in the body of the text.  Check this 
box if an ARL message number is used.  This box is 
automatically checked if the ARL Msg button is used 
to select an ARL message. 
 

Check Required Field.  This is the number of words in the 
text of the message.   
 
This field will automatically be updated whenever the 
Check or Save buttons are pushed.  If you enter a value 
in this field, it will be overwritten. 
 

Place of Origin Optional Field.  This is the general location where the 
message originated (not necessarily location of station 
origin) and is usually a city and state, or occasionally 
an event, such as 2009 Moffett Air Show, CA. 
 
If the City and State tags are filled in on the Report 
Settings form, then this field automatically will be set 
with <city>,  <state>. 
 

Time of Origin Optional field.  This field is automatically set to the PC 
system clock in the format hh:mm (i.e.:  12:30). 
 

Date of Origin Required field.  Usually is mmm dd format (i.e.: Sep 
18) and must correspond with date that this message 
was first entered into the NTS system. 
 

 



Outpost Packet Message Manager v2.7 
Users Guide 

January 15, 2013 131

14.4 Destination Address 

The following fields are part of the NTS Message Destination Address.  

Field Description 
Name Required field.  The name of the individual to whom 

this message is to be delivered. 
 

Call Sign Optional field.  If the recipient is an Amateur Radio 
Operator, enter his or her call sign here. 
 

Address Optional field.  Street address if available. 
 

City Required field.  The city where the recipient lives. 
 

State/Prov Required Field.  The state or province where the 
recipient lives. 
 

ZIP/Postal Code Required Field.  The 5 U.S. digit zip code or the 6 or 7 
character Canadian Postal Code where the recipient 
lives. 
 

Phone Number Highly Desirable (but optional) Field.  If a phone 
number is known, enter the Area Code, exchange, and 
number. 
 

14.5 Message Text and Signature 

The last two fields hold the body of the message and the signature.  

Field Description 
Message text Required Field.  If possible, the text should be limited 

to 25 words.   
 

Signature Required Field.  This is the signature (and call sign of 
the message was sent from another Amateur radio 
Operator) of the person sending the message.   
 
This is not necessarily the person who is sending the 
message by packet. 
 

14.6 Creating an NTS message 

Refer to the example in Figure 54: NTS Message Maker Form for how the form 
was initially filled in.  The general steps for using the NTS Message Maker are: 

1. From the Outpost main menu, press New to open the Message form. 

2. From the Message form, select File > NTS Message Maker. 

3. Fill in the fields.  When done, press Check to validate the entries and 
complete the message formatting.  If any required fields are missing, that 
field will be highlighted.  

4. When done, press Save.  The Message form is filled in with a correctly 
formatted NTS message.   

5. From the Message form, press Send. 
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14.7 Finishing up an NTS message 

Once the message is composed and all fields are filled in (per the figure above), 
press the Check button and Outpost updates the Preamble’s “Check” and Message 
fields.  Also, the status line indicates the results of the check.  The following is what 
the above message would look like after Check is pressed. 

Figure 55: NTS Message Maker after performing a Check 

 
Next, press the Save button.  Outpost writes the contents of the NTS Message 
Maker back to the Message form.  Note the Message Type is set to NTS.  

 

Figure 56: NTS Message written to the Message Form 

“Check” field is
calculated and 

Updated

Message is
Reformatted

Status
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Finally, press the Send button.  The NTS message shows up in the Outpost Out 
Tray and will be sent during the next Packet Session.  

Figure 57: An NTS Message in the Out Tray 

14.8 Selecting an ARL Message 

Outpost lets the user select and apply one or more ARL standard messages to an 
NTS message.  This works as follows: 

1. From the Outpost main menu, press New to open the Message form. 

2. From the Message form, select File > NTS Message Maker. 

3. Fill in the Preamble and Destination Address fields as described above. 

4. Press the ARL Msg button.  The ARL Dialog box opens.  The controls and 
fields associated with this dialog box are as follows: 

 
Controls Description 
Message Type Toggles between the list of Routine and Emergency 

ARL messages. 
 

Next, Previous Selects the next or previous ARL message based on the 
type selected. 

 
Apply Takes the ARL message and applies it to the NTS 

message. 

 

Cancel Cancels this operation. 

 

 

Message type
updated to NTS
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Field Description 
ARL Number The literal ARL number of the selected message. 

 
Message Text The message text associated with the selected ARL 

number.   
 
Some ARL messages require additional information to 
be provided by the user to complete the message.  This 
information can be found between the “<” and “>” 
characters. 
 

 

Figure 58: Defining an ARL Message 

5. Select the Message Type (either Routine or Emergency).  Using the Next 
and Previous buttons, select the desired message.  Press Apply when done. 

6. If additional information is required to complete the message, the user will 
be prompted for the fields that are required.  In the above example, 2 
additional prompts are issued: one for “Location”, and one for “Flight 
No/Train No/etc”. 

7. After the field is filled in (not shown here), the message is inserted into the 
NTS Form. 

8. Complete the balance of the NTS message as previously described. 

Figure 59: A completed ARL Message 

Formatted 
ARL Message
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15 Online Reports 
 

Several ARES/RACES organizations have developed standard reporting tools and 
formats for collecting and transmitting information over packet.  In some cases, 
automated tools have been used to generate the reports using pre-defined forms that 
could be interpreted for efficient processing.  Online Reports is how Outpost 
addresses this requirement. 

15.1 Introduction 

An Online Report begins as a report form template that is developed outside of 
Outpost and saved as standard ASCII file.  When loaded into an Outpost message, 
the form’s embedded “tags” are updated automatically and the user is prompted to 
enter information in specific locations on the report form. 

There are three things that need to occur for Outpost to generate an Online Report 
that is ready for sending: 

1. Set up the report values 

2. Create the report form (template) 

3. Process the report form in an Outpost message window 

This section describes these steps. 

15.2 Setting up the Report Values 

Report values refer to information that is typically referenced by one or more 
reports.  By defining these values up front, then referencing them with embedded 
<tags> in the report form, the report can be quickly filled in and sent on its way. 

 

Figure 60: Report Settings Menu 

To fill in the report variables, do the following: 

1. From the Outpost main menu, select Tools > Report Settings… 
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2. Fill in the fields.  When done, press OK.  

Typically, defining report values only has to be done once for all reports.  Once 
these fields are filled in, the report values will be referenced by a Report Form 
during processing.  See the Tag Definitions below for a description of these fields. 

15.3 Creating the Report Form 

Report forms are essentially ASCII text files that are post-processed by Outpost to 
create the final report.  The report form consists of 3 kinds of text entries: 

 General text.  This is canned text that is context-setting information to be sent 
as the report. 

 Tags.  Tags are variables that are embedded into a Report Form and then 
substituted with either automatic values or the values defined and stored by the 
“Report Settings” form. 

 Prompts.  A prompt is the character that is used to indicate the location where a 
user needs to input text for the report.  Outpost uses the equal sign (=) as the 
prompt character. 

Tag Definitions 

The following table lists the report form tags and their meaning.  Note the source 
from where the tag information originates.   

Table 1: Definition of Report Tags 

Tag name Description 

<D>, <date1> Date.  The current system date, the format being: 
mm/dd/yy (example: 5/21/04). 

Source: Automatic Value 

<date2> Date.  The current system date, the format being:  
dd-mmm-yyyy (example: 21-May-2004). 

Source: Automatic Value 

<T>, <time> Time.  The current system time, the format being: hh:mm 
(24 hour format). 

Source: Automatic Value 

<M>, <msg#> Message Number.  The next message number as maintained 
by the application. 

Source: Report Setting Form 

<C>, <call> Call.  The currently defined Station ID.  Go to the Outpost 
menu Setup > Identification… to change. 

Source: Automatic Value 

<name> User Name.  The name entered at the Station ID form. 

Source: Automatic Value 

<bbs> BBS.  The currently selected BBS name. 

Source: Automatic Value 

<subj>text Subject.  The text immediately following the <subj> tag is 
appended to the Subject Line.  This tag should be on its own 
line with no other tags.  It will not be included in the body 
of the report. 

<to>dest To.  The text immediately following the <to> tag is set in 
the To: address message field.  This tag should be on its 
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Tag name Description 

own line with no other tags.  It will not be included in the 
body of the report. 

<org> Organization.  The organization to which the sending 
station is affiliated, such as Cupertino ARES, Lake County 
RACES, etc. 

Source: Report Setting Form 

<city> City.  The City name. 

Source: Report Setting Form 

<county> County.  The County name. 

Source: Report Setting Form 

<state> State.  The 2-character representation of the state.  

Source: Report Setting Form, “State/Prov” field  

<province> Province.  The 2-character representation of the Province. 

Source: Report Setting Form, “State/Prov” field  

<tacloc> Tactical Location.  A reference to a location that is 
supporting a response, such as Quinlan Shelter, Deerfield 
Fire Station, or First Aid #1. 

Source: Report Setting Form 

<tacid> Tactical ID.  A 3-character string that can be used as a 
prefix to the message number to further ensure the 
message’s uniqueness. 

Source: Report Setting Form 

<text1> User-defined field.  This is 1 of 3 user-defined fields.  This 
field is also used as part of the Supplemental Tactical Call 
ID. 

Source: Report Setting Form 

<text2> User-defined field.  This is 2 of 3 user-defined fields. 

Source: Report Setting Form 

<text3> User-defined field.  This is 3 of 3 user-defined fields. 

Source: Report Setting Form 

= Prompt.  Causes Outpost to position the cursor at this 
location for the user to enter text. 

/ comment Comment.  Any text following this is considered a comment 
that will not be included when loaded into Outpost.   

The “/” character must be the 1st character on a line.  If the 
“/” character is any place else, it is considered part of the 
report. 

 

Tag Considerations 

 There are a few report variables that have 2 methods for representing them.  
Either method is valid. 

 Tags can be entered as either upper or lower case. 

 The same tag can be entered more than once in a report form. 



Outpost Packet Message Manager v2.7 
Users Guide 

January 15, 2013 138

 When using the user-defined tags, care must be taken to ensure all users 
interpret the fields the same way in particular if a Report Form with user-
defined tags are shared among several stations.  

 If any field on the Report Settings menu is left blank, and a tag referencing that 
field is used, the tag will be replaced with nothing. 

Creating the Report Form 

Report Forms can be created with any text editor PROVIDED it can produce an 
ASCII text file.  The two text editors that are standard with MS Windows are 
Notepad and Wordpad.  Additionally, any other word processor can be used 
provided it can produce an ASCII file. 

The following is a sample report form developed with Notepad.  Note the different 
tags used throughout the report, the comment lines ( / ), and the prompt locations  
( = ) where user input is required. 

 

Figure 61: Report Form in Notepad 

Once the report form is created, it should be stored in a common location with other 
report form files.  The recommended place is the in the  ..\reports 
subdirectory.  
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15.4 Processing the Report Form 

With the Report variables and Report Form defined, you are ready to process the 
report. 

To process a report form, do the following: 

1. From Outpost, select New to open a new message form. 

2. From the Message Form menu, select File > Open Report.  A file selection 
menu will open to the report directory you defined in the Directory 
Settings menu. 

3. Select the Report Form to be processed, and then press OK. 

 

Figure 62: Report Form in Message Window 

4. Once the form is loaded, all <tags> are substituted with their automatic 
(date and time) and Report Setting (Tactical ID, Message number, and City) 
values.  

5. Next, the cursor is positioned over the first prompt (=).  Type over the 
prompt (=) to answer that question, then press Cntl-TAB or  
Right-Mouse-Click to progress to the next prompt. 

6. Continue entering all requested information until all prompts are replaced.  
You will be prompted if you want to start from the top, or tell you that there 
were no prompts found. 

7. To re-start prompt processing if you stop, select  
File > Process a Report. 

8. To clear any remaining Prompts that are not to be filled in, select  
File > Clear Remaining Prompts. 

9. When done, fill in the balance of the Message header (To:, Subject:, etc) 
and press Send. 
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16 Interactive Packet Programs 
 

16.1 Introduction 

There are times when you want to directly interact with either the TNC or the BBS 
for channel monitoring, system maintenance or troubleshooting.  Outpost includes 
an interactive packet (IP) capability where the user can directly interact with the 
TNC or BBS.  This section describes this feature. 

There are 3 separate Interactive Packet programs that are called by Outpost to 
support the different interface methods:  serial port TNCs (Ipserial.exe), AGWPE 
(Ipagwpe.exe), and Telnet (Iptelnet.exe).  The menus and controls on all 3 programs 
are essentially the same, with minor variations to deal with the key interface 
differences. 

 

Figure 63: AGWPE’s Interactive Packet Window 

16.2 Menus, Tool Bar 

The following describes the Interactive Packet Program menus: 

Menus Description 
File Print.  Currently disabled. 

____________________________________________ 

Comm Setting.  SERIAL PORT ONLY.  Sets up the 
serial port where the TNC is located. 

AGWPE Settings:  AGWPE ONLY.  Setup screen 
for identifying the AGWPE server, port, and logon 
information. 

Pick Via Stations:  AGWPE ONLY.  Identifies the 
list of via stations needed to get to the BBS. 

Telnet Settings:  TELNET ONLY.  Setup screen for 
identifying the BBS server and port information. 

Exit:  Causes the program to exit. 
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Menus Description 
Edit Cut:  Copies and deletes any highlighted text from any 

field.  The text is placed in the MS-Windows clipboard. 

Copy: Copies any highlighted text in any field.  The 
text is placed in the MS-Windows clipboard. 

Paste:  Inserts text from the clipboard at the position 
where the cursor is located. 

____________________________________________ 

Select All:  Takes a copy of the entire contents of the 
IPW window and copies it to the MS-Windows 
clipboard. 

 

Tools (Serial 
Program) 

Serial Program 

Options.  Sets the Size of the Most Recent Used list 
and allows you turn on MON ON whenever you 
connect.   

Log to Text File.  Sets up the file that will be used to 
log all activities that occur once the Start Logging 
button is pressed. 

____________________________________________ 

Add Comm Port setting to Outpost.  Create an 
TNC entry in Outpost for the comm port currently in 
use. 

Get Comm Port setting from Outpost.  Pulls over 
the currently selected Comm Port setting from Outpost 
that is currently in use. 

Create Message in Outpost.  Takes the highlighted 
text and creates a message in the Draft Folder in 
Outpost 

____________________________________________ 

KISS Off.  Depending on the TNC manufacturer 
selected, it sends the right sequence of characters to the 
TNC to reset it from KISS mode to Command Mode. 

Host Off.  Depending on the TNC manufacturer 
selected, it sends the right sequence of characters to the 
TNC to reset it from Host mode to Command Mode. 

____________________________________________ 

Font.  Sets the font and size for this program. 

Reset Font.  Resets the font Size back to the default 
value. 

Tools (AGWPE 
Program) 

Serial Program 

Options.  Sets the Size of the Most Recent Used list, 
and turns on displaying raw data packets. 

Log to Text File.  Sets up the file that will be used to 
log all activities that occur once the Start Logging 
button is pressed. 

____________________________________________ 

AGWPE Version.  Returns the version of the 
currently running AGWPE program.  This menu option 
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Menus Description 
is enabled once you are connected to AGWPE. 

Add AGWPE setting to Outpost.  Create an 
AGWPE Device entry in Outpost for the AGWPE 
configuration currently in use. 

Create Message in Outpost.  Takes the highlighted 
text and creates a message in the Draft Folder in 
Outpost 

____________________________________________ 

Reset Font.  Resets the font Size back to the default 
value. 

Tools (Telnet 
Program) 

Serial Program 

Options.  Sets the Size of the Most Recent Used list. 

Log to Text File.  Sets up the file that will be used to 
log all activities that occur once the Start Logging 
button is pressed. 

____________________________________________ 

Add Telnet setting to Outpost.  Create an Telnet 
Device entry in Outpost for the Telnet configuration 
currently in use. 

Create Message in Outpost.  Takes the highlighted 
text and creates a message in the Draft Folder in 
Outpost 

____________________________________________ 

Reset Font.  Resets the font Size back to the default 
value. 

 

The following controls manage how the program executes: 

Controls Description 
Connect The connect button does different things depending on 

whether you are running the Serial Port, AGWPE, or 
Telnet version of Interactive Packet. 

Serial Port 

Pressing Connect opens the Comm Port and sends a 
Carriage Return to the TNC.  If the TNC is connected 
and turned on, you should see the TNC prompt.  The 
Comm port is also automatically opened when the user 
starts to type in the IPW text window. 

If the Comm Port is open to another Outpost process 
(Outpost’s Packet Session Manager) or program, an 
error will be displayed. 

Pressing Disconnect closes the Comm port. 

AGWPE 

Pressing Connect initiates the AGWPE sequence.   

1.  The user is prompted to enter his/her call sign.  The 
last call sign used is entered as the default entry.  Then, 
the program attempts to register this call sign with 
AGWPE. 

2.  If the registration is successful, the user is then 
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Controls Description 
prompted to enter the BBS to which he/she wants to be 
connected.  The last BBS name previously entered is 
listed as the default entry.  AGWPE attempts to connect 
to the BBS.  If the BBS is not reachable, AGWPE 
times out and reports an error. 

3.  If the AGWPE performs a connect, the user can then 
interact with the BBS as usual. 

Telnet 

Pressing Connect initiates the Telnet connect sequence. 
The program connects to the Telnet server, and the user 
is presented with the logon prompt. 

Once you log on, you can interact with the BBS as 
usual. 

 

Unproto Packet AGWPE only.  Initiates the AGWPE registration, then 
allows the user to type anything they wish in the text 
window.  These packets will immediately be sent out. 

Press Disconnect exit from the current AGWPE 
session. 

 

Disconnect After the Connect sequence is initiated, the text on the 
Connect button changes to Disconnect. 

When this button is pressed, the Interactive Packet 
program will initiate a disconnect from the specific 
interface to which it is connected.  In all cases, the 
disconnect is final. 

Once pressed, the button changes back to read 
Connect. 

 

Start Logging The Start Logging button is enabled once a file is 
selected and available for logging (Menu: Tools > Log 
to Text File).   

On pressing the Start Logging button, all subsequent 
text displayed in the text window will be written to the 
file regardless of whether it was entered by the user or 
returned from the device 

 

Stop Logging After the Logging is started as described above, the 
Start Logging button changes to read Stop Logging. 

When Stop Logging pressed, all logging to the file is 
stopped, and the button changes back to read Start 
Logging.   

If Start Logging is pressed again, the data is appended 
to the same file previously opened. 

 

Create Message Allows the user to create an Outpost message from any 
highlighted portion of the text window.   

If no text is highlighted, an error occurs. 

If the Interactive packet program is not in the same 
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Controls Description 
directory as the Outpost.exe program, this button will 
be disabled. 
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